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ΠΕΡΙΛΗΨΗ 

Κύριο θέμα εξέτασης της παρούσας μεταπτυχιακής εργασίας είναι η ανάλυση συστημάτων που περιέχουν 

στοιχεία με μη γραμμική συμπεριφορά από άποψη γεωμετρίας, όπως είναι τα καλώδια. Η ανάλυση θα 

πραγματοποιηθεί σε τρία διαφορετικά λογισμικά με σκοπό την εξαγωγή αποτελεσμάτων από αυτά και 

τη σύγκριση τους για την εξέταση της σύγκλισής τους. Τα λογισμικά που θα χρησιμοποιηθούν είναι τα 

ADINA, SAP2000 και ROBOT. Σε αυτά λοιπόν έγινε η προσπάθεια δημιουργίας όμοιων φορέων. Πρόκειται 

για έξι διαφορετικούς φορείς οι οποίοι επιβλήθηκαν και με διαφορετικές φορτίσεις για την εξέταση και 

αυτής της παραμέτρου. Η εξαγωγή έπειτα των αποτελεσμάτων έγινε με γραφήματα έτσι, ώστε η 

σύγκριση να είναι πιο προσιτή. Στο σώμα της εργασίας γίνεται και αναλυτική περιγραφή των φορέων. 

Ένα δεύτερο κομμάτι που εκτελέσθηκε επίσης είναι η περιγραφή κατά τη διαδικασία παραγωγής κάθε 

μοντέλου σε κάθε λογισμικό βήμα προς βήμα σε μορφή εγχειριδίου. Πιο αναλυτικά, η δομή που έχει η 

εργασία ξεκινάει με περιγραφή της μη γραμμικής ανάλυσης που είναι απαραίτητη για την αντιμετώπιση 

τέτοιου είδους φορέων. Στη συνέχεια, πραγματοποιείται περιγραφή των φορέων που δημιουργήθηκαν, 

όπως και αναλυτική περιγραφή του στησίματος αυτών σε κάθε λογισμικό. Επειδή όμως εξετάζονται 

διαφορετικής φιλοσοφίας φορείς, κρίνεται αναγκαίο να αναλυθεί η δημιουργία του καθενός σε ξεχωριστό 

κεφάλαιο. Σε κάθε επιμέρους κεφάλαιο γίνεται επίσης και η παρουσίαση-σύγκριση των αποτελεσμάτων. 
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ABSTRACT 

Major subject of this master thesis is the analysis of structures that consist of elements with geometric 

nonlinear behaviour. Cables are among those elements. The analysis is taking place on three different 

software programs in order to extract and compare their results for the examination of their 

convergence. The software programs that are being used, are ADINA, SAP2000 and ROBOT. Attempt 

was made to be built identical models in each of their graphical environment. The models that are being 

presented, are of six different structures that were loaded with different loads so as to examine this 

parameter, too. The results were extracted via graphs for the convenient comparison between them. 

Analytical description of each structure is taking place through the thesis. However, except from this 

comparison, an effort has been made for the accurate step by step description through the model 

building of each structure. Firstly, a description of nonlinear analysis, that is required for such structures, 

is taking place in order for the reader to familiarise with it. Next part is the description of each structure 

and the process of model building in each software. However, because of the peculiarity of each 

structure, a different chapter of each one is necessary. These chapters contain distinctive information 

of each model and the results, compared, through the analysis in the three software programs. 
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 ΣΥΓΚΡΙΣΗ ΕΝΑΛΛΑΚΤΙΚΩΝ ΤΡΟΠΩΝ ΑΝΑΛΥΣΗΣ ΚΑΛΩΔΙΩΤΩΝ ΚΑΤΑΣΚΕΥΩΝ  

1. ΕΙΣΑΓΩΓΗ 

1.1. ΚΑΛΩΔΙΩΤΕΣ ΚΑΤΑΣΚΕΥΕΣ 

Η χρήση των καλωδιωτών κατασκευών είναι ευρέως διαδεδομένη και συναντάται συνήθως σε 

κατασκευές μεγάλων διαστάσεων, όπου δε θα ωφελούσε η χρήση ενός άλλου τύπου τυπικής 

κατασκευής, όπως για παράδειγμα κατασκευές από σκυρόδεμα ή χάλυβα καθώς στην κλίμακα που 

αναφερόμαστε θα ήταν κοστοβόρες και αντιαισθητικές. Βλέποντας την Εικόνα 1-1 μπορούμε να 

καταλάβουμε την κλίμακα στην οποία αναφερόμαστε. Με άλλα λόγια, παρόλο τις μικρές σχετικά διατομές 

που χαρακτηρίζουν τα καλώδια, μας επιτρέπουν τη φόρτισή τους με μεγάλα φορτία. Αυτό στηρίζεται 

στο γενικό κανόνα της μεγάλης δυσκαμψίας που αναπτύσσουν με τη αλλαγή της γεωμετρίας τους κατά 

τη διάρκεια της φόρτισης. 

  

(α) (β) 

Εικόνα 1-1: (α) Καλωδιωτή γέφυρα Ρίου-Αντιρρίου ακτινικού τύπου, (β) Δίκτυο καλωδίων με μεμβράνη στο 
στάδιο Ειρήνης και Φιλίας 

Πέρα όμως μεγάλες κατασκευές μπορούμε να συναντήσουμε επίσης πολύ απλές συνθέσεις με τη χρήση 

καλωδίων ή και ενός καλωδίου. Χαρακτηριστικά παραδείγματα είναι οι δημιουργία μικρών τεντών με τη 

χρήση μεμονωμένων καλωδίων ή λίγο μεγαλύτερης κλίμακας κατασκευή όπως αυτή ενός επίτονου ιστού. 

Μπορούμε να δούμε αυτά τα παραδείγματα στην Εικόνα 1-2. 
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(α) (β) 

Εικόνα 1-2: (α) Κατασκευή τέντας με τη χρήση μεμονωμένων καλωδίων, (β) Κατασκευή επίτονου ιστού [1] 

1.2. ΙΔΙΑΙΤΕΡΟΤΗΤΕΣ ΣΤΑΤΙΚΗΣ ΣΥΜΠΕΡΙΦΟΡΑΣ ΚΑΛΩΔΙΩΤΩΝ ΚΑΤΑΣΚΕΥΩΝ 

Το κύριο χαρακτηριστικό των καλωδιωτών κατασκευών, όπως αναφέρθηκε και προηγουμένως, είναι η 

ανάληψη μεγάλων φορτίων συγκριτικά με τις μικρές διατομές των χρησιμοποιούμενων στοιχείων. Αυτό 

είναι δυνατόν χάρη στην ανάπτυξη όλο και μεγαλύτερης δυσκαμψίας των συστημάτων με την επιβολή 

αυξανόμενων φορτίων. Με τη χρήση λοιπόν τέτοιων στοιχείων μπαίνει στην εξίσωση η παράμετρος της 

γεωμετρικής μη γραμμικότητας, δηλαδή το γεγονός ότι οι μετατοπίσεις δεν είναι αμελητέες σε σύγκριση 

με τις χαρακτηριστικές διαστάσεις του φορέα. Αυτό όμως αποτελεί και την πρώτη διαφορά στον τρόπο 

προσέγγισης μιας καλωδιωτής κατασκευής σε σύγκριση με τις μεθόδους στατικής ανάλυσης συμβατικών 

φορέων [1] 

1.3. ΣΤΟΧΟΣ ΚΑΙ ΔΟΜΗ ΤΗΣ ΕΡΓΑΣΙΑΣ 

Αυτό που εξετάζεται λοιπόν στην παρούσα διπλωματική εργασία είναι η ανάλυση τέτοιων συστημάτων 

σε τρία διαφορετικά λογισμικά, η εξαγωγή αποτελεσμάτων από αυτά και τέλος η σύγκριση τους με σκοπό 

την εξέταση της σύγκλισής τους. Πρόκειται για τα λογισμικά ADINA, SAP2000 και ROBOT. Πιο 

συγκεκριμένα, δημιουργήθηκαν σε αυτά, μοντέλα έξι διαφορετικών φορέων με διάφορους τύπους 

φορτίσεων. Έπειτα εξήχθησαν τα αποτελέσματα με τα οποία δημιουργήθηκαν γραφήματα έτσι, ώστε η 

σύγκριση να είναι πιο προσιτή. Παρακάτω λοιπόν θα δούμε αναλυτικότερη περιγραφή των μοντέλων 

αυτών. Πέρα από τη σύγκριση όμως, σε μεγάλο μέρος της εργασίας, θα γίνει προσπάθεια να περιγραφεί 

και η διαδικασία παραγωγής κάθε μοντέλου σε κάθε λογισμικό βήμα προς βήμα σε μορφή εγχειριδίου. 

Όσον αφορά τη δομή εργασίας, ξεκινάει με την εξοικείωση του αναγνώστη στο θέμα της μη γραμμικής 

ανάλυσης, απαραίτητης για την αντιμετώπιση τέτοιου είδους φορέων. Στη συνέχεια, γίνεται περιγραφή 

των φορέων που δημιουργούνται, καθώς και αναλυτική περιγραφή του στησίματος αυτών σε κάθε 

επιμέρους λογισμικό. Εξετάζοντας όμως διαφορετικής φιλοσοφίας φορείς, παρουσιάζεται η ανάγκη να 

αναλύεται η δημιουργία του καθενός σε ξεχωριστό κεφάλαιο. Στα ανάλογα κεφάλαιο επίσης γίνεται και 

η παρουσίαση-σύγκριση των αποτελεσμάτων.
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2. ΜΗ ΓΡΑΜΜΙΚΗ ΑΝΑΛΥΣΗ 

Η μη γραμμική ανάλυση είναι ένα είδος ανάλυσης που χρησιμοποιείται σε κατασκευές όπου 

παρατηρούνται φαινόμενα μη γραμμικότητας γεωμετρίας ή υλικού. Στους φορείς μας λοιπόν 

διενεργούμε μη γραμμική ανάλυση καθώς παρουσιάζονται φαινόμενα μεγάλων μετακινήσεων, λόγω της 

παρουσίας των καλωδίων. Με άλλα λόγια, οι σχέσεις που συνδέουν τα διάφορα μεγέθη μεταξύ τους δεν 

είναι γραμμικές, δηλαδή το ένα δεν είναι ανάλογο του άλλου, οπότε δεν ισχύει η αρχή της επαλληλίας. 

Η πραγματοποίηση λοιπόν της συγκεκριμένης ανάλυσης πραγματοποιείται με υπολογισμούς και εξαγωγή 

αποτελεσμάτων σε κάθε στάδιο της. Αυτό γίνεται με επιβολή του φορτίου σε βήματα. Πιο συγκεκριμένα, 

τα φορτία και οι υπολογισμοί δεν λαμβάνονται στο ακέραιό τους, αλλά αυξάνονται και εξάγονται, 

αντίστοιχα, σταδιακά μέχρι την επίτευξη ενός επιπέδου ισορροπίας. [2] 

Η μέθοδος που χρησιμοποιείται ως επί το πλείστον για την επίλυση μη γραμμικών εξισώσεων ισορροπίας 

προσομοιωμάτων είναι αυτή της Full Newton-Raphson. Σύμφωνα με τη μέθοδο αυτή, το φορτίο 

διαιρείται σε κάποιο αριθμό βημάτων που ορίζουμε εμείς. Με την άσκηση κάθε βήματος προκύπτει μία 

μετακίνηση, ενώ η επόμενη άσκηση του φορτίου γίνεται λαμβάνοντας τη δυσκαμψία που έχει το 

σύστημα εκείνη την ώρα. Ενώνοντας γραμμικά τα σημεία σε ένα διάγραμμα P-δ, θέλουμε να είναι όσο 

πιο κοντά γίνεται στη φυσική λύση του προβλήματος. Επομένως όσο περισσότερα βήματα τόσο 

μικρότερο το σφάλμα που θα έχουμε. Για παράδειγμα, αν σε κάθε βήμα έχουμε σφάλμα της τάξεως 

1‰, τότε στο τέλος μιας ανάλυσης, όπου το φορτίο έχει διαιρεθεί σε 100 βήματα, το σφάλμα που θα 

προκύψει θα είναι 1%. Σε κάθε βήμα λοιπόν γίνεται έλεγχος των εσωτερικών εντάσεων και των 

εξωτερικών φορτίων έτσι, ώστε η σχετική διαφορά τους να μην ξεπερνάει κάποιο όριο που έχουμε 

ορίσει. Αν υπάρχει υπέρβαση του πραγματοποιούνται επαναλήψεις μέχρι την επίτευξή του. Το ιδιαίτερο 

γνώρισμα της Full Newton-Raphson είναι η αλλαγή της οριζόμενης δυσκαμψίας σε αυτή που παρουσιάζει 

το σύστημα την εκάστοτε στιγμή και δεν διατηρεί τη δυσκαμψία από την αρχή του βήματος, κάτι που 

χαρακτηρίζει μια παραλλαγή της μεθόδου, την Modified Newton-Raphson. Αυτό καθιστά την πλήρη 

μέθοδο N-R να είναι πιο αργή αλλά να απαιτεί λιγότερες επαναλήψεις σε κάθε βήμα για την επίτευξη της 

επιθυμητής σύγκλισης. Κατά την επίλυση λοιπόν ενός μη γραμμικού προβλήματος με ένα λογισμικό, 

θέτουμε τον αριθμό των βημάτων που θέλουμε να διαιρεθεί το φορτίο επιβολής, τον αριθμό των 

επαναλήψεων μέχρι τη σύγκλιση καθώς και το επίπεδο σύγκλισης που επιθυμούμε. Αν έχουμε λοιπόν 

ένα καλά στημένο μοντέλο και η σύγκλιση αποτυγχάνει, πρέπει να μεταβληθεί μία από τις παραπάνω 

παραμέτρους. [3]
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3. ΠΕΡΙΓΡΑΦΗ ΕΞΕΤΑΖΟΜΕΝΩΝ ΦΟΡΕΩΝ 

3.1. ΦΟΡΕΙΣ ΜΕΜΟΝΩΜΕΝΩΝ ΚΑΛΩΔΙΩΝ 

Στο κεφάλαιο των μεμονωμένων καλωδίων θα αναλύσουμε τα διάφορα μοντέλα που δημιουργήθηκαν. 

Να αναφέρουμε αρχικά ότι τα καλώδια έχουν την ιδιότητα να παραλαμβάνουν μόνο αξονικές 

εφελκυστικές τάσεις. Όσον αφορά τη γεωμετρία του φορέα, απαίτηση ήταν η κάλυψη απόστασης 6 

μέτρων με μεμονωμένο καλώδιο τόσο χωρίς, όσο και με αρχική κρέμαση, που εμφανίζεται στην Εικόνα 

3-1. Εξετάστηκαν, λοιπόν, τρεις περιπτώσεις κρέμασης. Πιο συγκεκριμένα, εξετάστηκαν οι περιπτώσεις 

S0=1.05×L, S0=1.10×L και S0=1.15×L, όπου S0 το μήκος του καλωδίου και L το άνοιγμα που θέλουμε 

να καλύψουμε. Τα μοντέλα κάθε περίπτωσης φορτίστηκαν με τρεις διαφορετικούς τρόπους, με 

συγκεντρωμένο φορτίο στο μέσον τους, με κατανεμημένο φορτίο κατά μήκος της οριζόντιας προβολής 

τους και με κατανεμημένο φορτίο κατά μήκος του τόξου τους. Τα φορτία που ασκήθηκαν σε κάθε 

επιμέρους μοντέλο εξαρτήθηκαν από το περιθώριο αξονικής έντασης που μπορεί να παραλάβει κάθε ένα 

το οποίο περιμένουμε και θα δούμε ότι αυξάνεται με την αύξηση της κρέμασης. 

  

(α) (β) 

Εικόνα 3-1:(α) Μεμονωμένο καλώδιο χωρίς κρέμαση και (β) με κρέμαση 

3.2. ΕΠΙΤΟΝΟΣ ΙΣΤΟΣ 

Η κατασκευή ενός επίτονου ιστού πραγματοποιείται με δικτυώματα και ολοκληρώνεται με τη στήριξή 

του σε διάφορα υψόμετρα με τη βοήθεια προεντεταμένων καλωδίων. Τα δικτυώματα αποτελούνται, 

όσον αφορά τα κατακόρυφα τμήματα από μη συμπαγείς κοίλες κυκλικές διατομές, ενώ τα οριζόντια και 

διαγώνια τμήματα απαρτίζονται από διατομές γωνιακών, όπως φαίνονται στην Εικόνα 3-2. Στη συνέχεια 

τοποθετούνται τα καλώδια σε δύο διαφορετικά ύψη και προς τρεις κατευθύνσεις. Συνολικά δηλαδή 

τοποθετούνται έξι καλώδια. Το τελικό σχήμα δικτυώματος του ιστού που δημιουργήθηκε φαίνεται στην 

Εικόνα 3-3 στην περίπτωση (α). Στη βάση του κορμού του ο καλωδιωτός ιστός έχει άρθρωση, καθώς 

θέλουμε κατά τη μετακίνησή του να παραμένει όσο το δυνατόν περισσότερο ευθύγραμμος. Σε αυτόν 

ασκήθηκε ένα ισοδύναμο στατικό φορτίο ανέμου με κατεύθυνση στα θετικά του άξονα Y όπως φαίνεται 

στην Εικόνα 3-3. Η τελική γεωμετρία του φορέα φαίνεται στην Εικόνα 3-4. [1] 
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(α) (β) 

Εικόνα 3-2: (α) Διατομές δικτυώματος ιστού όπως φαίνονται στο λογισμικό SAP2000 [4], (β) Λεπτομέρεια 
δικτυώματος [4] 
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Εικόνα 3-3: Χαρακτηριστικές διατομές κορμού καλωδιωτού ιστού και περιπτώσεις φόρτισης ανέμου [1] 



8  ΚΕΦΑΛΑΙΟ 3 

ΜΕΤΑΠΤΥΧΙΑΚΗ ΕΡΓΑΣΙΑ ΤΟΥ ΔΗΜΗΤΡΙΟΥ ΠΑΠΑΔΟΓΙΑΝΝΑΚΗ Ε.Μ.Π. - 2020 

 

 

(α) (β) 

Εικόνα 3-4: (α) Κάτοψη και (β) όψη επίτονου ιστού 

3.3. ΑΝΗΡΤΗΜΕΝΗ ΓΕΦΥΡΑ 

Η μόρφωση της γέφυρας πραγματοποιήθηκε με δύο πυλώνες πάνω στους οποίους τρέχουν τα κύρια 

καλώδια που τους συνδέουν για την κάλυψη του μεσαίου ανοίγματος. Επίσης συνδέουν τους πυλώνες 

με τα άκρα της γέφυρας. Αυτό σημαίνει ότι τα κύρια καλώδια στηρίζονται σε τέσσερα σημεία, στις 

κορυφές των δύο πυλώνων και στα άκρα του καταστρώματος. Τα καλώδια αυτά παρουσιάζουν μεγάλη 

κρέμαση, στο μεσαίο άνοιγμα κυρίως, στην οποία και αποδίδεται η αποδοτικότητα τους. Όσον αφορά 

το μεσαίο άνοιγμα τοποθετήθηκαν επίσης δευτερεύοντα καλώδια συνδέοντας κατακόρυφα τα κύρια 

καλώδια με το κατάστρωμα σχηματίζοντας το σύστημα ανάρτησης. Το κατάστρωμα τρέχει από το ένα 

άκρο της γέφυρας στο άλλο και στηρίζεται αρθρωτά στα άκρα, στους δύο πυλώνες καθώς και στα 

δευτερεύοντα καλώδια, που ονομάζονται και αναρτήρες. Τόσο τα κύρια όσο και τα δευτερεύοντα 

καλώδια είναι εκεί για την παραλαβή εφελκυστικών τάσεων, ενώ οι πυλώνες καταπονούνται κατά κύριο 

λόγο σε θλίψη από τη μεταφορά των φορτίων εκατέρωθεν Συνολικά το σύστημα στηρίζεται με 

πακτώσεις στη βάση των πυλώνων και αρθρωτά στα άκρα του καταστρώματος. Γέφυρες τέτοιου τύπου 

χρησιμοποιούνται για την κάλυψη μεγάλων ανοιγμάτων και δεν είναι επιθυμητή η τοποθέτηση πυλώνων 

προς το μέσο του καταστρώματος. Από στατικής άποψης, τα φορτία μίας ανηρτημένης γέφυρας που 

ασκούνται στο κατάστρωμα μεταφέρονται από τους αναρτήρες στα κύρια καλώδια, τα οποία με τη σειρά 

τους τα μεταφέρουν στους πυλώνες για να καταλήξουν στο έδαφος. Τα φορτία που ασκήθηκαν στην 

περίπτωσή μας είναι το ίδιο βάρος της κατασκευής και ένα κατανεμημένο φορτίο των 100kN/m κατά 
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μήκος του καταστρώματος. Η τελική γεωμετρία του συστήματος που προκύπτει παρουσιάζεται στην 

Εικόνα 3-5. [5] 

 

Εικόνα 3-5: Όψη ανηρτημένης γέφυρας 

3.4. ΚΑΛΩΔΙΩΤΗ ΓΕΦΥΡΑ ΑΚΤΙΝΙΚΟΥ ΤΥΠΟΥ 

Σε αυτού του είδους τη γέφυρα έχουμε ένα τύπο καλωδίου, σε αντίθεση με την ανηρτημένη, που 

συμβάλλει στη στήριξη του καταστρώματος από τους πυλώνες. Τα καλώδια ξεκινούν από την κορυφή 

των πυλώνων με διαφορετικές γωνίες και καταλήγουν στο κατάστρωμα το οποίο και στηρίζουν. Εδώ 

λοιπόν τα φορτία μεταφέρονται από το κατάστρωμα μέσω των καλωδίων στους πυλώνες για να 

καταλήξουν και πάλι στο έδαφος. Τα καλώδια σε τέτοιους φορείς απαιτείται να βρίσκονται πάντα υπό 

συνθήκες αξονικού εφελκυσμού για να μην επέρχεται χαλάρωση σε αυτά σε καμία περίπτωση φόρτισης. 

Έτσι σχεδιάζονται με την τάση εφελκυσμού τους να έχει ένα κάτω όριο. Τέτοιου τύπου στατικά 

συστήματα χρησιμοποιούνται σε μικρότερα ανοίγματα συγκριτικά με τον προηγούμενο τύπο καθώς όσο 

αυξάνεται το άνοιγμα, αυξάνεται και ο αριθμός των πυλώνων που πρέπει να τοποθετηθούν. Εν τέλει 

καταλήγουμε να έχουμε μία γεωμετρία της Εικόνα 3-6. Τα φορτία στην περίπτωση αυτή είναι ίδια με 

αυτά της ανηρτημένης. [5] 

 

Εικόνα 3-6: Όψη καλωδιωτής γέφυρας ακτινικού τύπου 

3.5. ΥΛΙΚΑ ΚΑΙ ΔΙΑΤΟΜΕΣ 

3.5.1. Δομικά υλικά 

Τα υλικά που χρησιμοποιήθηκαν στην παρούσα μελέτη είναι τα παρακάτω: 

 Χάλυβας καλωδίων 

o Μέτρο ελαστικότητας:  Ε=177GPa 
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o Όριο διαρροής1:  fy=1770MPa 

o Λόγος Poisson:  v=0.3 

o Σταθερά θερμικής διαστολής: Α=1.2×10-5 

 Δομικός Χάλυβας 

o Μέτρο ελαστικότητας:  Ε=210GPa 

o Όριο διαρροής:  fy=275MPa 

o Λόγος Poisson:  v=0.3 

o Σταθερά θερμικής διαστολής: Α=1.17×10-5 

 Σκυρόδεμα 

o Μέτρο ελαστικότητας:  Ε=35GPa 

o Όριο διαρροής:  fc=40MPa 

o Λόγος Poisson:  v=0.2 

o Σταθερά θερμικής διαστολής: Α=1×10-5 

3.5.2. Διατομές στοιχείων 

3.5.2.1. Μεμονωμένα καλώδια 

 Καλώδιο 

o Διάμετρος:    D=1.3cm 

o Εμβαδό διατομής:   Α=0.785cm2 

o Συντελεστής μεταλλικής επιφάνειας: C=0.59 (ελικοειδής κλώνος με συνολικό αριθμό 

συρμάτων τα 37 και πιθανή ονομαστική διάμετρο 6 έως 36mm 

A=π∙D
2
/4∙C (3-1) 

3.5.2.2. Επίτονος ιστός 

 Καλώδια 

o Διάμετρος:    D=1.3cm 

o Εμβαδό διατομής:   Α=0.785cm2 

o Συντελεστής μεταλλικής επιφάνειας: C=0.59 

 Κατακόρυφα στοιχεία 

o Διάμετρος (εξωτερική): D=15cm 

o Πάχος τοιχώματος:  tw=6mm 

 Διαγώνια και οριζόντια στοιχεία 

o Μήκος πέλματος: Η=10cm 

o Πάχος πέλματος: tf=6mm 

3.5.2.3. Ανηρτημένη γέφυρα 

 Κύρια καλώδια 

o Διάμετρος:    D=5.2cm 

o Εμβαδό διατομής:   Α=12.3cm2 

o Συντελεστής μεταλλικής επιφάνειας: C=0.58 (ελικοειδής κλώνος με συνολικό αριθμό 

συρμάτων τα 91 και πιθανή ονομαστική διάμετρο 30 έως 52mm) 

 Δευτερεύοντα καλώδια 

                                                
1 Χαλύβδινα σύρματα κυκλικής διατομής. 



ΠΕΡΙΓΡΑΦΗ ΕΞΕΤΑΖΟΜΕΝΩΝ ΦΟΡΕΩΝ  11 

 

o Διάμετρος:    D=2cm 

o Εμβαδό διατομής:   Α=1.82cm2 

o Συντελεστής μεταλλικής επιφάνειας: C=0.58 (ελικοειδής κλώνος με συνολικό αριθμό 

συρμάτων τα 61 και πιθανή ονομαστική διάμετρο 20 έως 40mm) 

 Υποστυλώματα πυλώνων 

o Μήκος: L=1m 

o Πλάτος: W=1m 

 Δοκοί πυλώνων 

o Ύψος:  H=1m 

o Πλάτος W=0.7m 

 Δοκός πυλώνων κάτω από το κατάστρωμα 

o Ύψος:  H=2m 

o Πλάτος W=1.5m 

 Κατάστρωμα (κοίλη διατομή) 

o Εξωτερικό ύψος: H=1.5m 

o Πλάτος:  W=6m 

o Πάχος:  t=0.5m 

3.5.2.4. Καλωδιωτή γέφυρα ακτινικού τύπου 

 Καλώδια 

o Διάμετρος:    D=4cm 

o Εμβαδό διατομής:   Α=7.29cm2 

o Συντελεστής μεταλλικής επιφάνειας: C=0.58 (ελικοειδής κλώνος με συνολικό αριθμό 

συρμάτων τα 91 και πιθανή ονομαστική διάμετρο 30 έως 52mm) 

 Υποστυλώματα πυλώνων 

o Μήκος: L=1m 

o Πλάτος: W=1m 

 Δοκοί πυλώνων 

o Ύψος:  H=1m 

o Πλάτος W=0.7m 

 Δοκός πυλώνων κάτω από το κατάστρωμα 

o Ύψος:  H=2m 

o Πλάτος W=1.5m 

 Κατάστρωμα (κοίλη διατομή) 

o Εξωτερικό ύψος: H=1.5m 

o Πλάτος:  W=6m 

o Πάχος:  t=0.5m





 

 ΣΥΓΚΡΙΣΗ ΕΝΑΛΛΑΚΤΙΚΩΝ ΤΡΟΠΩΝ ΑΝΑΛΥΣΗΣ ΚΑΛΩΔΙΩΤΩΝ ΚΑΤΑΣΚΕΥΩΝ  

4. ΠΕΡΙΓΡΑΦΗ ΧΡΗΣΙΜΟΠΟΙΟΥΜΕΝΩΝ 

ΛΟΓΙΣΜΙΚΩΝ 

Παρακάτω παρουσιάζεται η διαδικασία για κάθε ένα από τα λογισμικά που χρησιμοποιήθηκαν. Οι επιλογές 

που έγιναν όσον αφορά τη δημιουργία του μοντέλου, την επιβολή των φορτίων και τον τρόπο ανάλυσης 

είναι όμοιες και στα τρία ούτως, ώστε να συγκρίνουμε αποτελέσματα που προέρχονται από ίδιο τρόπο 

αντιμετώπισης των μοντέλων. 

4.1. ADINA 

4.1.1. Βασικές αρχές 

Στο ADINA δεν ορίζουμε από κάποιο μενού τις μονάδες μέτρησης οπότε κάνουμε μια αρχική παραδοχή 

για κάθε μέγεθος. Οι μονάδες μέτρησης λοιπόν αυτές θα πρέπει να τηρούνται ίδιες σε κάθε μενού στη 

συνέχεια. Η παραδοχή που έχει γίνει για όλα τα μοντέλα που θα περιγραφούν στη συνέχεια είναι η 

μέτρηση του μήκους σε m, της δύναμης σε kN και της έντασης σε kPa. Επίσης περιγράφεται παρακάτω 

ο τρόπος επιλογής της επαναληπτικής μεθόδου επιβολής του φορτίου. 

 Control > Solution Process: Επιλέγουμε την μέθοδο με την οποία θα γίνει η επαναληπτική διαδικασία 

καθώς και τα κριτήρια σύγκλισης αυτής. Επιλέγοντας Iteration Method οδηγούμαστε στο μενού 

όπου επιλέγουμε για μέθοδο την Full Newton-Raphson και Maximum Number of Iterations τις 15. 

Στη συνέχεια από το μενού για Iteration Tolerances επιλέγουμε Energy για μέγεθος με το οποίο θα 

ελέγχεται η σύγκλιση και στη συνέχεια εισάγουμε στο κελί Energy Tolerance τη συνθήκη κάτω από 

την οποία θα υφίσταται σύγκλιση. Χρησιμοποιήθηκε η προκαθορισμένη τιμή 0, η οποία υποδηλώνει 

την προεπιλεγμένη τιμή του λογισμικού που είναι 0,001. 

4.1.2. Γεωμετρία φορέα 

Για την προσθήκη των στοιχείων μας πρέπει αρχικά να γίνει εισαγωγή σημείων και στη συνέχεια γραμμών 

που καθορίζονται από αυτά τα σημεία. Στη συνέχεια πάνω σε αυτά ορίζουμε τα μέλη του φορέα μας. 

Αυτό λοιπόν γίνεται με την εξής διαδικασία: 

 Geometry > Points: Το μενού αυτό όπως και τα παρακάτω βρίσκεται ενώ είμαστε στο περιβάλλον 

ADINA Structures. Εδώ λοιπόν εισάγουμε τις συντεταγμένες των σημείων που στη συνέχεια 

καθορίζουν τις γραμμές και ως επακόλουθο τα στοιχεία του φορέα. 
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 Geometry > Lines > Define: Προσθέτουμε τις γραμμές σύμφωνα με τα σημεία που έχουμε ήδη 

εισάγει. Επιλέγουμε λοιπόν τα επιθυμητά σημεία που θέλουμε να ενώνει είτε εισάγοντάς τα 

αριθμητικά, είτε από το περιβάλλον. 

4.1.3. Δημιουργία υλικού 

4.1.3.1. Χάλυβας καλωδίων 

Αρχικά δημιουργούμε το υλικό που θέλουμε να χρησιμοποιήσουμε στο καλώδιό μας. Το υλικό μας 

θέλουμε να είναι απείρως ελαστικό και να μην παίρνει θλίψη. Η διαδικασία που ακολουθούμε λοιπόν είναι 

η εξής: 

 Model > Materials > Manage materials: Από την κατηγορία Elastic επιλέγουμε το υλικό μας να είναι 

Nonlinear. Πατώντας Add ενεργοποιούνται τα κελιά για το ορισμό των ιδιοτήτων του υλικού μας. 

Ορίζουμε το όνομα του, την πυκνότητα μάζας του, το λόγο Poisson και στον πίνακα για Stress-

Strain Curve ορίζουμε τις τιμές που θέλουμε έτσι, ώστε το υλικό να μην παραλαμβάνει θλίψη. Οι 

τιμές που ορίστηκαν παρουσιάζονται στον επόμενο πίνακα οι οποίες παρουσιάζονται και σε 

διάγραμμα. Ο Λόγος Poisson στη συγκεκριμένη περίπτωση δεν ορίζεται καθώς ορίζουμε τα στοιχεία 

καλωδίου με truss elements, όπως θα δούμε και παρακάτω, στα οποία δεν εφαρμόζεται λόγος 

Poisson στο συγκεκριμένο λογισμικό. 

Πίνακας 4-1: Ορισμός υλικού καλωδίου με δυνατότητα παραλαβής εφελκυστικών αλλά όχι θλιπτικών τάσεων 

Strain Stress(kPa) 

-1.0 0.0 

0.0 0.0 

1.0 1.77e8 

 

Σχήμα 4-1: Συμπεριφορά υλικού καλωδίου 

4.1.3.2. Δομικός χάλυβας 

 Model > Materials > Manage materials: Σαν υλικό του δομικού χάλυβα θα επιλέξουμε Plastic-

Bilinear. Τροποποιούμε τα χαρακτηριστικά του υλικού και το αποθηκεύουμε. 
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4.1.4. Δημιουργία διατομής 

Περιγράφεται ο ορισμός μιας τυπικής διατομής, η επιλογή της οποίας γίνεται σε επόμενο βήμα όπου 

δημιουργούμε τον τύπο του στοιχείου προσομοίωσης. Στη περίπτωση όμως του καλωδίου ο ορισμός της 

διατομής του πραγματοποιείται από διαφορετικό μενού με τον ορισμό απλά του εμβαδού της. 

 Model > Cross Sections: Επιλέγουμε τον τύπο της διατομής και τροποποιούμε τα γεωμετρικά 

στοιχεία της. 

 Meshing > Elements > Element Data: Σε αυτό το μενού παρουσιάζονται όλα τα πεπερασμένα 

στοιχεία με τις λεπτομέρειές τους μετά τη διαδικασία της διακριτοποίησης. Ορίζουμε λοιπόν 

ανάμεσα σε άλλα και το εμβαδό της διατομής στην πινακίδα του μενού για τα στοιχεία που 

απαρτίζουν το καλώδιο. Πιο συγκεκριμένα, εισάγουμε στη στήλη Section Area το επιθυμητό εμβαδό 

του κάθε στοιχείου. Σε περίπτωση πολλών στοιχείων για να αποφύγουμε τη αλλαγή του Section 

Area σε κάθε ένα ξεχωριστά, μπορούμε να διαγράψουμε τα στοιχεία και έπειτα να τα εισάγουμε με 

αυτόματο τρόπο με το πάτημα του κουμπιού Auto. Έτσι δίνουμε το Section Area που θέλουμε και 

αφήνοντας τις τιμές των υπολοίπων στηλών ως είχαν. Πρέπει να προσέξουμε λοιπόν πριν σβήσουμε 

τα στοιχεία να συγκρατήσουμε τις τιμές των υπολοίπων στηλών. 

4.1.5. Δημιουργία στοιχείων προσομοίωσης και διακριτοποίηση 

Σε όλα τα μοντέλα που θα ακολουθήσουν γίνεται εισαγωγή καλωδίων οπότε εδώ παρουσιάζεται ο τρόπος 

των αντίστοιχων στοιχείων προσομοίωσης και ο τρόπος διακριτοποίησής τους. Όσον αφορά την 

εκάστοτε διακριτοποίηση, εξαρτάται από το είδος του μοντέλου που έχουμε να αντιμετωπίσουμε. 

Ορίζουμε αρχικά τον τύπο στοιχείων που θα χρησιμοποιήσουμε για την προσομοίωση του καλωδίων. 

Κάνουμε χρήση στοιχείων Truss, καθώς το ADINA δε διαθέτει στοιχεία Cable για αυτό το σκοπό. Έπειτα 

ορίζουμε την πυκνότητα της διακριτοποίησης που θέλουμε να έχει κάθε γραμμή που έχουμε τοποθετήσει 

και εφαρμόζουμε σε αυτές τον τύπο κάθε στοιχείου, δημιουργώντας και με αυτόν τον τρόπο την τελική 

διακριτοποίηση στο φορέα. 

 Meshing > Element Groups: Προσθέτουμε καινούριο τύπο στοιχείου Truss και ορίζουμε το υλικό 

που θα έχει αυτός ο τύπος. 

 Meshing > Mesh Density > Line: Ορίζουμε την πυκνότητα της διακριτοποίησης που θα έχει κάθε 

γραμμή στο μοντέλο μας. Επιλέγουμε τη γραμμή ή άλλο είδος στοιχείου που έχουμε σχηματίσει και 

διαμορφώνουμε τις ιδιότητες της διακριτοποίησης. Η επιλογή αυτή γίνεται για ένα μόνο στοιχείο 

επιλέγοντάς το από την αντίστοιχη λίστα ή γράφοντας όλα τα στοιχεία που επιθυμούμε να γίνει η 

ίδια διακριτοποίηση στον πίνακα του μενού. 

 Meshing > Create Mesh > Line: Επιλέγουμε τον τύπο και την ομάδα που θέλουμε να ανήκει το 

στοιχείο που θα αποδοθεί στην εκάστοτε γραμμή. Έπειτα εισάγουμε στον πίνακα του μενού τις 

γραμμές στις οποίες θέλουμε να εφαρμόσουμε αυτή την ομάδα στοιχείων. 

4.1.6. Εισαγωγή συνθηκών στήριξης 

Επιλέγουμε αρχικά τους βαθμούς ελευθερίας που θέλουμε να είναι ενεργοί στο μοντέλο μας. Στη 

συνέχεια ορίζουμε τις συνθήκες στήριξης και τις εφαρμόζουμε στα αντίστοιχα σημεία. 

 Control > Degrees of Freedom: Επιλέγουμε τους βαθμούς ελευθερίας που θα είναι ενεργοί. Στα 

μοντέλα μας επιλέξαμε X-Translation, Y-Translation και Z-Rotation. 

 Model > Boundary Conditions > Define Fixity: Ορίζουμε τις συνθήκες στήριξης που θέλουμε να 

εφαρμόσουμε στο μοντέλο μας. Προσθέτουμε καινούριο τύπο συνθήκης και επιλέγουμε τους 

βαθμούς ελευθερίας που θέλουμε να δεσμεύσουμε. 

 Model > Boundary Conditions > Apply Fixity: Εφαρμόζουμε τις συνθήκες αυτές σε υπάρχοντα 

σημεία. Επιλέγουμε τον τύπο της συνθήκης που δημιουργήσαμε πριν και έπειτα εισάγουμε στον 

αντίστοιχο πίνακα τα σημεία που θέλουμε να εφαρμοσθεί. 
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 Model > Boundary Conditions > Apply Fixity On Nodes: Πρόκειται για δεύτερο τρόπο εφαρμογής 

στηρίξεων. Εδώ εισάγουμε τους κόμβους που επιθυμούμε και ορίζουμε τους αντίστοιχους βαθμούς 

ελευθερίας ως Fixed ή Free. 

4.1.7. Εισαγωγή φορτίων 

Σε όλα τα μοντέλα θέλουμε να υπολογιστεί το φορτίο από το ίδιο βάρος της κατασκευής και όποιο άλλο 

φορτίο έχουμε επιλέξει για κάθε τύπο κατασκευής. Περιγράφεται παρακάτω η διαδικασία εισαγωγής των 

φορτίων. Πριν από την εισαγωγή όμως των φορτίων πρέπει να εισάγουμε και τα Time Functions 

σύμφωνα με τα οποία θα γίνεται η επιβολή κάθε διαφορετικού τύπου φορτίου, καθώς και τα βήματα 

στα οποία επιθυμούμε να γίνει η επιβολή. 

 Control > Time Step: Στο μενού αυτό επιλέγουμε τον αριθμό των βημάτων στα οποία θα 

επιβληθούν τα φορτία που θα αντιστοιχούν σε Time Function με το συγκεκριμένο Time Step, τη 

διάρκεια του κάθε βήματος (Magnitude) και τον συνολικό θεωρητικό χρόνο της λύσης (Solution 

Time). Ουσιαστικά θα πρέπει No. of Steps ×Magnitude=Solution Time. Για παράδειγμα, εάν 

επιθυμούμε το φορτίο να ασκηθεί σε 100 βήματα, ορίζουμε σύνολο βημάτων τα 101 (καθώς στο 

πρώτο θα γίνεται η επιβολή του ίδιου βάρους), διάρκεια βήματος ίση με 0.01 και ο συνολικός 

θεωρητικός χρόνος λύσης που προκύπτει ισούται με 1.01. Τα Time Functions που θα αντιστοιχούν 

σε συγκεκριμένο Time Step θα πρέπει να έχουν τελικό χρόνο ίσο με το Solution Time του 

αντίστοιχου Time Step. Σε περίπτωση που ο αριθμός των βημάτων δεν είναι επαρκής μεταβάλλουμε 

το Time Step και το αντίστοιχο Time Function. Αν και πάλι δεν επιτυγχάνεται η επιθυμητή σύγκλιση 

ορίζουμε να γίνεται αυτόματα ο ορισμός της διάρκειας του κάθε βήματος επιλέγοντας Use Automatic 

Time Stepping (ATS) πατώντας το κουμπί  στο περιβάλλον του ADINA. 

 Control > Time Function: Ορίζουμε τα Time Functions. Η χρησιμότητα αυτών βρίσκεται στο γεγονός 

ότι κάθε φορτίο αντιστοιχίζεται σε κάποιο Time Function και σύμφωνα με αυτό επιβάλλεται. Με 

άλλα λόγια, ορίζεται πότε το φορτίο θα αρχίσει να επιβάλλεται και με τι ρυθμό θα πραγματοποιείται 

μέχρι να φτάσει σε κάποιο ποσοστό της τιμής του. 

 Meshing > Elements > Element Data: Η προένταση επιβάλλεται σε αυτό το μενού για κάθε 

επιμέρους στοιχείο καλωδίου στη λίστα Initial Strain ως αρχική παραμόρφωση. Αυτό 

πραγματοποιείται με τη δημιουργία ουσιαστικά του στοιχείου, οπότε στο αρχικό στάδιο, παράλληλα 

με το ίδιο βάρος του καλωδίου. Η τιμή της αρχικής παραμόρφωσης προκύπτει από την αντίστοιχη 

τιμή της προέντασης που θέλουμε να επιβάλουμε, μέσω του νόμου του Hooke που φαίνεται στην 

Εξ. (4-1). 

σ=Ε∙ε⇒
Τ

Α
=Ε∙ε⇒ ε=

Τ

Ε∙Α
 (4-1) 

, όπου σ: η τάση του καλώδιο 

  Ε: το μέτρο ελαστικότητας του καλωδίου 

  Τ: η αξονική ένταση του καλωδίου 

  ε: η σχετική παραμόρφωση του καλωδίου 

  Α: το εμβαδό του καλωδίου 

 Model > Loading > Apply: Επιλέγουμε τον τύπο του φορτίου που θέλουμε να επιβάλουμε και τη 

θέση που θέλουμε να επιβληθεί. 

o Για ίδιο βάρος: Επιλέγουμε ως Load Type το Mass Proportional, Apply to Model και έπειτα 

διαλέγουμε το Time Function σύμφωνα με το οποίο θέλουμε να επιβληθεί. 

o Για συγκεντρωμένο φορτίο: Επιλέγουμε ως Load Type το Force. Πατώντας το κουμπί Define 

ανοίγει καινούριο μενού όπου ορίζουμε έναν τύπο δύναμης, δηλαδή το μέτρο της και την 



ΠΕΡΙΓΡΑΦΗ ΧΡΗΣΙΜΟΠΟΙΟΥΜΕΝΩΝ ΛΟΓΙΣΜΙΚΩΝ  17 

 

κατεύθυνσή της. Επιστρέφοντας στο προηγούμενο μενού διαλέγουμε αυτόν τον τύπο δύναμης 

και έχοντας επιλέξει Apply to Point, εισάγουμε στον πίνακα του μενού το σημείο που θέλουμε 

να επιβληθεί και το Time Function κατά το οποίο θα επιβληθεί. 

 Model > Loading > Apply Load On Nodes/Elements: Εισάγουμε στον πίνακα του μενού τον κόμβο 

τον οποίο έχει δημιουργηθεί μετά τη διακριτοποίηση και στον οποίο θέλουμε να ασκήσουμε ένα 

συγκεντρωμένο φορτίο. Επιλέγουμε επίσης X-Force, Y-Force ή Z-Force ανάλογα με την κατεύθυνση 

που θέλουμε να έχει το φορτίο μας. Ορίζουμε τέλος και το μέγεθός της καθώς και το Time Function 

κατά το οποίο θα ασκείται. 

Με τον ίδιο τρόπο επιβάλλεται και το κατανεμημένο φορτίο κατά μήκος του τόξου πάνω σε στοιχείο 

τύπου Truss που είναι τα καλώδια. Αυτό γίνεται γιατί τα στοιχεία αυτά δέχονται μόνο αξονικά 

φορτία. Έτσι χωρίσαμε το καλώδιο σε πολλά τμήματα και τοποθετήσαμε σημειακά φορτία 

αντίστοιχης δύναμης στους κόμβους ανάμεσα στα τμήματα για να προσομοιωθεί το κατανεμημένο 

φορτίο. Με αυτόν τον τρόπο προσομοιώθηκε το κατανεμημένο φορτίο κατά μήκος της χορδής του 

καλωδίου. Έστω λοιπόν ότι το καλώδιο μας έχει μήκος 6m και το χωρίζουμε σε 100 ίσα τμήματα 

των 0.06m. Αν έχουμε ένα κατανεμημένο φορτίο 10kN/m τότε θα ασκήσουμε συγκεντρωμένα 

φορτία στους κόμβους όπως φαίνεται στην Εικόνα 4-1 όπου εμφανίζεται η αρχή ενός καλωδίου. 

 

Εικόνα 4-1: Προσομοίωση κατανεμημένου φορτίου με σημειακά φορτία 

Σημειώνουμε εδώ ότι αν θέλαμε η δύναμη να είχε κάποια συγκεκριμένη κατεύθυνση πέραν των 

τριών αξόνων θα διαλέγαμε την επιλογή Follower Force Acting from Aux. Node και θα εισήγαμε τον 

κόμβο από τον οποίο θα διερχόταν. Αυτή η ιδιότητα χρησιμοποιήθηκε για την προσομοίωση του 

κατανεμημένου φορτίου κατά μήκος της οριζόντιας προβολής. Η διαδικασία λοιπόν που 

ακολουθήθηκε ήταν η εξής. Πάνω από το αρχικό καλώδιο δημιουργήθηκε άλλο ένα βοηθητικό στο 

οποίο έγινε η ίδια διακριτοποίηση έτσι, ώστε να δημιουργηθούν κόμβοι ακριβώς πάνω γεωμετρικά 

από τους κόμβους του αρχικού. Αυτό έγινε για να μπορούμε να ασκήσουμε δυνάμεις στους κόμβους 

του καλωδίου μας, για τις οποίες χρειάζεται ο ορισμός κόμβων από τους οποίους θα διέρχεται η 

διεύθυνσή κάθε δύναμης. Καθώς προχωράνε τα βήματα της ανάλυσης και καμπυλώνεται όλο και 

περισσότερο το καλώδιο πέρα από τις κατακόρυφες μετατοπίσεις των σημείων του, έχουμε και 

οριζόντιες μετατοπίσεις. Οι δυνάμεις συνεχίζουν να ασκούνται πάνω στα μετατοπισμένα σημεία 

αλλά οι διευθύνσεις τους περνάνε από τα σημεία του βοηθητικού καλωδίου που δημιουργήσαμε 

από πάνω, τα οποία παραμένουν σχεδόν ακίνητα καθώς έχει οριστεί να είναι αρκετά δύσκαμπτο. 

Έτσι οι δυνάμεις παίρνουν μία κλίση από την κατακόρυφο με αποτέλεσμα μετά από την ανάλυση 

της δύναμης να έχουμε μικρότερο μέτρο σε κατακόρυφη διεύθυνση από αυτό που είχαμε σε κάθε 

προηγούμενο βήμα. Η δύναμη σε οριζόντια διεύθυνση ωστόσο δεν μας επηρεάζει. Οπότε, παρόλο 

που οι δυνάμεις ασκούνται κατά μήκος του τόξου του καλωδίου, με αυτόν τον τρόπο 

προσομοιώνεται η άσκηση τους κατά μήκος της οριζόντιας προβολής. Παράδειγμα με τμήμα αρχής 

καλωδίου που έχει καμπυλωθεί μετά από άσκηση φορτίου φαίνεται στην Εικόνα 4-2. 
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Εικόνα 4-2: Προσομοίωση κατανεμημένου φορτίου κατά μήκος οριζόντιας προβολής 

4.1.8. Επίλυση μοντέλου 

 Solution > Data File/Run: Με αυτόν τον τρόπο ξεκινάει η επίλυση του μοντέλου. Μας ζητείται να 

αποθηκεύσουμε τα δεδομένα της επίλυσης σε ένα αρχείο τύπου .dat και αφού γίνει αυτό 

εμφανίζεται ένα παράθυρο από το οποίο πατώντας το κουμπί View output μπορούμε να δούμε τις 

λεπτομέρειες της ανάλυσης. Πιο συγκεκριμένα, παρατηρούμε τα βήματα της ανάλυσης και πως σε 

κάθε βήμα εφαρμογής του φορτίου συγκλίνει η μη γραμμική ανάλυση. 

4.1.9. Παρουσίαση αποτελεσμάτων 

Για την παρουσίαση των αποτελεσμάτων, είτε αριθμητικών είτε γραφικών, αλλάζουμε περιβάλλον και 

μεταφερόμαστε στο Post-Processing. 

 File > Open: Ανοίγουμε το αρχείο τύπου .por που έχει δημιουργηθεί μετά την ανάλυση. Εμφανίζεται 

η παραμορφωμένη κατάσταση του φορέα μας στο τελικό στάδιο. 

 Definition > Model Point > Node: Ορίζουμε τον κόμβο ή τους κόμβους για τους οποίους 

ενδιαφερόμαστε να ελέγξουμε ένα οποιοδήποτε μέγεθος. Αυτό θα μπορούσε να είναι για 

παράδειγμα η μετακίνηση ή το φορτίο που επιβάλλεται σε αυτόν. Για τα αποτελέσματα μας 

χρειάστηκαν και τα δύο αυτά. Πιο συγκεκριμένα στο μοντέλο του μεμονωμένου καλωδίου, ορίσαμε 

ως κόμβο ενδιαφέροντος το μεσαίο κόμβο, καθώς σε αυτόν ασκούμε το συγκεντρωμένο φορτίο 

μας, αλλά θέλουμε επίσης να ελέγξουμε τη μετακίνησή του. Στο μενού αυτό εισάγουμε τον αριθμό 

του κόμβου ή απλούστερα τον επιλέγουμε, αφού πρώτα έχουμε εμφανίσει τους κόμβους στο 

μοντέλο μας με το αντίστοιχο κουμπί.  

 Definition > Model Point > Element: Ορίζουμε επίσης ένα στοιχείο ενδιαφέροντος μετά τη 

διακριτοποίηση που έχει γίνει, στο οποίο επίσης θέλουμε να δούμε αριθμητικά μεγέθη που έχουν 

προκύψει, όπως την ένταση του. Στο μενού αυτό, όπως και στο προηγούμενο εισάγουμε ή 

επιλέγουμε το στοιχείο που μας ενδιαφέρει. Επίσης για την εξέταση της έντασης που μας ενδιαφέρει 

πρέπει να επιλέξουμε από το υπομενού Defined by την παράμετρο Isoparametric Coordinates και 

στη συνέχεια να εισάγουμε τον αριθμό -1 στο κελί της παραμέτρου r. 

 List > Extreme Values > Zone: Παρουσιάζεται για ένα μέγεθος η μέγιστη τιμή όσον αφορά το 

σύνολο του μοντέλου και που αυτή εμφανίζεται. 



ΠΕΡΙΓΡΑΦΗ ΧΡΗΣΙΜΟΠΟΙΟΥΜΕΝΩΝ ΛΟΓΙΣΜΙΚΩΝ  19 

 

 List > Extreme Values > Model Point: Βρίσκουμε εδώ ό,τι και στο παραπάνω μενού απλά για ένα 

συγκεκριμένο σημείο ή στοιχείο το οποίο έχουμε διαλέξει από την αντίστοιχη λίστα αφού πρώτα το 

έχουμε ορίσει όπως αναφέραμε παραπάνω. 

 List > Value List > Zone: Σε αντίθεση με τα δύο παραπάνω μενού από εδώ μπορούμε να 

εμφανίσουμε όποιο μέγεθος θέλουμε για όλα τα σημεία ή στοιχεία του μοντέλου σε όλα τα βήματα 

μέχρι το πέρας της ανάλυσης. 

 List > Value List > Model Point: Ίδια λειτουργία με το παραπάνω μενού. Έχουμε όμως τη 

δυνατότητα να επιλέξουμε συγκεκριμένο σημείο ή στοιχείο που έχουμε ορίσει. 

 Graph > Response Curve (Model Point): Αυτό το μενού σε αντίθεση με όλα τα παραπάνω μας 

επιτρέπει να παρουσιάσουμε κάποιο γράφημα όπου βλέπουμε την αλληλεπίδραση δύο μεγεθών. 

Από το υπομενού X-Coordinate επιλέγουμε το μέγεθος που θέλουμε για τον οριζόντιο άξονα. Για 

τον έλεγχο της έντασης ενός στοιχείου επιλέγουμε Force και στη συνέχεια FORCE-R και επίσης το 

στοιχείο που έχουμε ορίσει προηγουμένως. Όμοια δρούμε και στην περίπτωση της μετακίνησης. 

Επιλέγουμε Displacement και έπειτα Y-DISPLACEMENT, καθώς και το αντίστοιχο σημείο που έχουμε 

ορίσει. Από το υπομενού Y-Coordinate επιλέγουμε επίσης το επιθυμητό μέγεθος για τον 

κατακόρυφο άξονα. Για να εμφανίσουμε το ασκούμενο φορτίο επιλέγουμε Prescribed Load και Y-

PRESCRIBED_FORCE, όπως και το σημείο που αυτό ασκείται. Πατώντας λοιπόν Apply παρουσιάζεται 

στο περιβάλλον το αντίστοιχο γράφημα. 

 Graph > List: Παίρνουμε τις τιμές των μεγεθών που απεικονίζονται στο γράφημα σε κάθε βήμα 

επιβολής τους φορτίου. Αν έχουμε εμφανίσει πολλά γραφήματα επιλεγούμε από την αντίστοιχη 

λίστα ή από το περιβάλλον αυτό που θέλουμε. Οι τιμές αυτές μπορούν επίσης να εξαχθούν σε 

αρχείο .txt. 

4.2. SAP2000 

4.2.1. Γεωμετρία φορέα 

Αρχίζουμε φτιάχνοντας ένα καινούριο αρχείο με κάναβο τέτοιο, ώστε να μπορούμε να τοποθετήσουμε 

εύκολα το φορέα μας. Επιλέγουμε επίσης τα μεγέθη που θέλουμε να διαχειριζόμαστε κατά τη διάρκεια 

την ανάλυσης. 

 File > New Model: Από το μενού που προκύπτει μετά τη συγκεκριμένη εντολή, αφού έχουμε επιλέξει 

από τη λίστα των Templates το Grid Only, ορίζουμε τους άξονες τους κανάβου. Δηλαδή επιλέγουμε 

από πού θα αρχίζει ο κάθε άξονας, πόσα σημεία ενδιαφέροντος θέλουμε σε κάθε έναν και την 

απόσταση που αυτά θα απέχουν. Όσον αφορά τα μεγέθη, επιλέγουμε kN, m και C. 

4.2.2. Δημιουργία υλικού 

 Define > Material: Ορίζουμε το υλικό μας προσθέτοντας ένα καινούριο. 

o Για το υλικό των καλωδίων: Επιλέξαμε Europe για Region, Steel για Material Type και User για 

Standard. Επιλέγοντας μετά το υλικό και πατώντας Modify/Show Material μπορούμε να το 

επεξεργαστούμε περαιτέρω. 

o Για το υλικό του δομικού χάλυβα: Επιλέξαμε Europe για Region, Steel για Material Type, ως 

Standard το ΕΝ 1993-1-1 και τέλος την ποιότητα του χάλυβα που επιθυμούμε. 

o Για το υλικό του σκυροδέματος: Επιλέξαμε Europe για Region, Concrete για Material Type, ως 

Standard το ΕΝ 1992-1-1 και την ποιότητα του σκυροδέματος που θέλουμε. 

4.2.3. Δημιουργία διατομής 

 Define > Section Properties > Cable Sections: Προσθέτουμε νέα διατομή καλωδίου. Επιλέγουμε για 

υλικό αυτό που είχαμε δημιουργήσει προηγουμένως καθώς και το εμβαδό της διατομής που θέλουμε 

να έχει. 
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4.2.4. Δημιουργία στοιχείων προσομοίωσης και διακριτοποίηση 

 Draw > Draw Frame/Cable/Tendon: Από το μενού που εμφανίζεται επιλέγουμε ως τύπο 

αντικειμένου που θα εισάγουμε τον τύπο Cable καθώς και τη διατομή που δημιουργήσαμε 

προηγουμένως. Έπειτα επιλέγουμε στο περιβάλλον τα σημεία του κανάβου που θέλουμε να 

ενώσουμε με το αντικείμενο και αφού πρόκειται για καλώδιο ανοίγει αυτόματα μία φόρμα για την 

τροποποίηση στοιχείων όπως η διακριτοποίηση του καλωδίου και ο τρόπος άσκησης της 

προέντασης σε αυτό. Στην περίπτωση που επιθυμούμε να δώσουμε την προένταση σαν δύναμη σε 

ένα από τα άκρα επιλέγουμε για Cable Type το Cable – Tension At I-End και στην παράμετρο 

Tension At I-End εισάγουμε την προένταση που επιθυμούμε να έχει το καλώδιο στη συνέχεια. Να 

σημειώσουμε εδώ ότι σε αυτό το στάδιο δεν ορίζεται ουσιαστικά η προένταση, αλλά εισάγουμε το 

μέτρο της έτσι, ώστε να ορισθεί η αρχική γεωμετρία του αφόρτιστου καλωδίου. Η περίπτωση αυτή 

του ορισμού δύναμης προέντασης στο ένα άκρο του καλωδίου χρησιμοποιήθηκε για τον τύπο 

μοντέλου καλώδιο χωρίς κρέμαση. Για τους άλλους τύπους μοντέλων ορίσαμε το σχετικό μήκος 

του αφόρτιστου καλωδίου σε σχέση με την απόσταση που καλείται να καλύψει. Αυτό γίνεται 

επιλέγοντας από το μενού για τον ορισμό του καλωδίου ως Cable Type το Cable – Relative 

Undeformed Length και ορίζοντας στο αντίστοιχο κελί ποιο είναι το σχετικό απαραμόρφωτο μήκος, 

για παράδειγμα 1.15 φορές η απόσταση των άκρων του καλωδίου. Ορίζουμε επίσης τον αριθμό των 

τμημάτων που θα διακριτοποιηθεί το καλώδιο και το εισάγουμε στην παράμετρο Number of Cable 

Segments. Εδώ αξίζει να σημειωθεί πως αν επιλέξουμε μικρό αριθμό και το λογισμικό απαιτεί 

μεγαλύτερο, αυτόματα διαιρεί το καλώδιο σε πολλαπλάσιο αριθμό κομματιών από αυτό που 

εισήγαμε. Μπορούμε επίσης να αλλάξουμε τον τρόπο με τον οποίο θα παρουσιάζεται το meshing 

στο μοντέλο μας. Αυτό γίνεται από το υπομενού Object Line Meshing όπου επιλέγουμε αν το 

καλώδιο θα παρουσιάζεται ως ένα αντικείμενο, αν θα διαιρείται σε ίσου μήκους τμήματα ή αν θα 

διαιρείται σε τμήματα με ίσο μήκος προβολής. Στα μοντέλα που ασκείται συγκεντρωμένο φορτίο ή 

που επιθυμούμε να παρακολουθήσουμε τη συμπεριφορά συγκεκριμένου κόμβου κάποιου καλωδίου 

επιλέχθηκε το δεύτερο ενδεχόμενο έτσι, ώστε να δημιουργηθούν κόμβοι. Σε διαφορετική 

περίπτωση επιλέγουμε την εμφάνισή του ως ενιαίου αντικειμένου. 

4.2.5. Εισαγωγή συνθηκών στήριξης 

 Assign > Joint > Restraints: Αφού έχουμε επιλέξει τους κόμβους που θέλουμε να δεσμεύσουμε από 

το μενού αυτό επιλέγουμε τους βαθμούς ελευθερίας που θέλουμε να δεσμεύσουμε. Υπάρχουν και 

έτοιμες επιλογές δεσμεύσεων για πάκτωση, άρθρωση, κύλιση ή ελεύθερος κόμβος. 

4.2.6. Εισαγωγή φορτίων 

 Define > Load Patterns: Ορίζουμε τα διάφορα είδη φορτίων που θέλουμε. Στο μοντέλο μας ορίσαμε 

ένα φορτίο DEAD για να προσομοιώσουμε το ίδιο βάρος του καλωδίου και επιλέξαμε να είναι τύπου 

Dead. Σε αυτό το φορτίο αποδώσαμε συντελεστή ίδιου βάρους ίσο με τη μονάδα. Ορίστηκε επίσης 

φορτίο TARGET τύπου Other για την προένταση. Όσον αφορά μόνιμα φορτία, όπως το 

συγκεντρωμένο ή το κατανεμημένο φορτίο, ορίζουμε το επιθυμητό κάθε φορά όνομα του και ως 

τύπο Other. 

 Define > Load Cases: Δημιουργούμε τις περιπτώσεις φορτίσεων. Αρχικά δημιουργούμε μία MODAL 

Case. Εισάγουμε ως μέγιστο αριθμό ιδιομορφών τις 12. Επόμενη περίπτωση φόρτισης είναι η 

TARGET. Επιλέγουμε, στο μενού της φόρτισης, Zero Initial Conditions και Static Nonlinear Analysis. 

Ως Modal Load Case επιλέγουμε την MODAL, ενώ στον πίνακα των φορτίων που ασκούνται κατά 

την περίπτωση αυτή επιλέξαμε τόσο το TARGET όσο και το DEAD καθώς επιθυμούμε να ασκούνται 

ταυτόχρονα σε πρώτο στάδιο. Επίσης εισάγουμε για κάθε μόνιμο φορτίο και την αντίστοιχη 

περίπτωση φόρτισης με το αντίστοιχο όνομα. Για αυτή διαλέγουμε να γίνεται επίσης σε πλαίσιο 

Static Nonlinear Analysis, ενώ για αρχική κατάσταση επιλέγουμε Continue from State at End of 

Nonlinear Case, η οποία και είναι η περίπτωση TARGET. Αυτό γίνεται γιατί πρέπει το συγκεντρωμένο 
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φορτίο να ασκείται αφού έχουν ασκηθεί το ίδιο βάρος και η προένταση. Ως Modal Load Case 

επιλέγεται επίσης η περίπτωση MODAL και το φορτίο που ασκείται εδώ είναι το αντίστοιχο που 

έχουμε δημιουργήσει. 

 Assign > Joint Loads > Forces: Μέσω του μενού αυτού εισάγουμε μεμονωμένα φορτία σε κόμβους. 

Με αυτόν τον τρόπο εισάγουμε για παράδειγμα το συγκεντρωμένο φορτίο στο μέσον μεμονωμένου 

καλωδίου 

 Assign > Cable Loads > Distributed: Εισάγουμε κατανεμημένο φορτίο σε καλώδιο. Το μενού μας 

δίνει τη δυνατότητα να ορίσουμε πέρα από την κατεύθυνση του φορτίου και το αν αυτό θα ασκείται 

κατά μήκος του στοιχείου ή κατά μήκος της οριζόντιας προβολής του. 

 Assign > Cable Loads > Target Force: Ο τρόπος αυτός άσκησης της προέντασης χρησιμοποιείται 

για τα μοντέλα με καλώδια χωρίς κρέμαση. Αφού έχουμε επιλέξει όλα τα στοιχεία που απαρτίζουν 

το καλώδιο, ενεργοποιείται το μενού μέσω του οποίου εφαρμόζουμε την προένταση. Επιλέγουμε 

στο μενού τη φόρτιση TARGET και πόσο επιθυμούμε αυτή να είναι. Εδώ πρέπει να σημειωθεί ότι 

για να περιμένουμε σωστά αποτελέσματα από την ανάλυση, πρέπει να εισάγουμε μέτρο δύναμης 

ίσο με αυτό που είχαμε εισάγει στη φόρμα για τη διακριτοποίηση του καλωδίου και τον τρόπο 

άσκησης της προέντασης στο λογισμικό, που παρουσιάστηκε στο κεφάλαιο 4.2.4. 

4.2.7. Επίλυση μοντέλου 

 Analyze > Run Analysis: Αφού έχουμε δημιουργήσει το φορέας μας τρέχουμε την ανάλυση. Από το 

μενού αυτό προτού προβούμε στην ανάλυση μπορούμε να επιλέξουμε ποιες περιπτώσεις φόρτισης 

επιθυμούμε να τρέξουν καθώς και το αν εμφανιστεί το παράθυρο με τις λεπτομέρειες της ανάλυσης. 

 Analyze > Show Last Run Details: Μπορούμε και μέσω αυτής της εντολής να παρουσιάσουμε το 

παράθυρο με τις λεπτομέρειες της ανάλυσης. Μέσω αυτού ελέγχουμε για τη σύγκλιση της μη 

γραμμικής ανάλυσης. Αν το TARGET-FORCE ITERATION RELATIVE ERROR είναι μικρότερο της 

μονάδας μπορούμε να πούμε ότι η ανάλυση έχει συγκλίνει και τα αποτελέσματα που έχουμε είναι 

σωστά. Αυτό επαληθεύεται και από το μήνυμα TARGET-FORCE ITERATION HAS CONVERGED. 

4.2.8. Παρουσίαση αποτελεσμάτων 

 Display > Show Plot Functions: Επιλέγουμε δύο μεγέθη για να δούμε γραφικά τη σχέση τους. Πέρα 

από το γράφημα όμως μπορούμε να πάρουμε και τις τιμές για αυτά τα μεγέθη που αντιστοιχούν σε 

κάποιο κόμβο ή στοιχείο του φορέα. Αρχικά επιλέγουμε την περίπτωση φόρτισης που θέλουμε και 

έπειτα ορίζουμε τα μεγέθη που θέλουμε να ελέγξουμε και τα στοιχεία που αυτά αντιστοιχούν. Αυτό 

γίνεται από το υπομενού Choose Plot Functions πατώντας Define Plot Functions. Για να μπορέσουμε 

να εισάγουμε σε γράφημα κάποιο επιβαλλόμενο φορτίο επιλέγουμε από τη λίστα το Add Load 

Functions και έπειτα το φορτίο που θέλουμε. Για τον έλεγχο της μετακίνησης κάποιου κόμβου 

επιλέγουμε Add Joint Disps/Forces και στο μενού που ανοίγει εισάγουμε τον αριθμό του κόμβου 

καθώς και το μέγεθος που θέλουμε να ελέγξουμε σε αυτόν, στην περίπτωσή μας τη μετακίνηση, 

και σε ποια διεύθυνση. Όσον αφορά έλεγχο αξονικής έντασης επιλέγουμε Add Frame Forces και 

στο επόμενο μενού εισάγουμε το όνομα του στοιχείου και το μέγεθος προς έλεγχο. Αφού έχουν 

δημιουργηθεί τα παραπάνω εμφανίζονται στη λίστα του υπομενού Choose Plot Functions. 

Επιλέγουμε ένα από αυτά για τον οριζόντιο άξονα του γραφήματος και ένα ή παραπάνω για τον 

κατακόρυφο άξονα. Υπάρχει επίσης επιλογή να ονομάσουμε τους άξονες. Ένα πλεονέκτημα που 

μας δίνει το SAP2000 είναι ότι μπορούμε να αποθηκεύσουμε, πατώντας το κουμπί Save Named Set, 

την αντιστοιχία των Plot Functions στους άξονες ως πρότυπο για επόμενα αποτελέσματα. Η χρήση 

ενός προτύπου γίνεται από το κουμπί Show Named Set. Τέλος, πατώντας Display εμφανίζεται το 

επιθυμητό γράφημα σε νέο μενού. 

 File > Print Graphics: Αυτό το μενού όπως και τα δύο επόμενα υπάρχουν στο παράθυρο 

παρουσίασης του γραφήματος που έχουμε εμφανίσει. Τυπώνουμε έτσι το γράφημα μας σε χαρτί ή 

σε αρχείο τύπου .pdf. 
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 File > Print Tables: Τυπώνουμε τα αριθμητικά αποτελέσματα των μεγεθών αυτών όπως αυτά 

προκύπτουν σε κάθε βήμα της ανάλυσης. 

 File > Print Tables to File: Εξάγουμε τα αποτελέσματα σε αρχείο τύπου .txt για επεξεργασία με άλλο 

πρόγραμμα. 

4.3. ROBOT 

4.3.1. Γεωμετρία φορέα 

 Geometry > Axis Definition: Εδώ ορίζουμε τον κάναβο που θα μας βοηθήσει στη δημιουργία του 

μοντέλου μας. Εισάγουμε για κάθε διεύθυνση το πρώτο σημείο του κανάβου, αν θα υπάρχουν 

επόμενα σημεία και την απόσταση την οποία αυτά θα απέχουν. 

4.3.2. Δημιουργία υλικού 

 Tools > Job Preferences: Πηγαίνοντας στο υπομενού Materials μπορούμε να διαλέξουμε ένα από 

τα υπάρχοντα υλικά ή να δημιουργήσουμε το δικό μας. Για την προσθήκη νέου υλικού πατάμε το 

κουμπί Modification. Στο μενού που εμφανίζεται αφού δώσουμε στο υλικό μας τις ιδιότητες που 

επιθυμούμε και το όνομα πατώντας Add προστίθεται στη λίστα των διαθέσιμων υλικών. 

4.3.3. Δημιουργία διατομής 

 Geometry > Properties > Cables: Για να ορίσουμε καινούρια διατομή καλωδίου πατάμε το κουμπί 

New cable. Στη συνέχεια ορίζουμε το όνομα, τη διατομή και το υλικό του καθώς και το πώς 

θεωρούμε ότι ασκείται η προένταση σε αυτό. Με άλλα λόγια, την ορίζουμε ως τάση ή ως δύναμη 

προέντασης ή ως μήκος καλωδίου (μπορεί να είναι διαφορετικό από την απόσταση που θέλουμε να 

καλύψει) ή τέλος σαν (σχετική) παραμόρφωση. Σε όλα τα μοντέλα, πέρα από αυτό του καλωδίου 

χωρίς κρέμαση, έγινε επιλογή της σχετικής παραμόρφωσης στη φόρμα δημιουργίας των καλωδίων. 

Για το καλώδιο χωρίς κρέμαση ορίσαμε τη δύναμη προέντασης που θέλουμε να επιβάλλουμε. Τέλος, 

σε περίπτωση που θέλουμε να τροποποιήσουμε υπάρχουσα διατομή κάνουμε διπλό κλικ στο όνομα 

στη λίστα των διατομών καλωδίων. 

4.3.4. Δημιουργία στοιχείων προσομοίωσης και διακριτοποίηση 

 Geometry > Bars: Εισάγουμε τη διατομή του καλωδίου στο περιβάλλον εργασίας. Στο κελί Bar Type 

του μενού επιλέγουμε Cable, όσον αφορά την εισαγωγή καλωδίου, ενώ στο κελί Section την 

διατομή της επιλογής μας. Έπειτα διαλέγουμε στο περιβάλλον τα άκρα του καλωδίου. Το καλώδιο 

αντιμετωπίζεται σαν ενιαίο από το πρόγραμμα χωρίς να γίνεται κάποια διακριτοποίηση. Αυτό μας 

αρκεί για όλα τα μοντέλα πέρα από τα μεμονωμένα καλώδια με κρέμαση, όπου και ακολουθούμε 

διαφορετική διαδικασία η οποία θα αναλυθεί στο κεφάλαιο 6.3.1. Για την εισαγωγή διαφορετικού 

τύπου στοιχείου ή διαφορετικής διατομής προχωράμε στις ανάλογες επιλογές στα κελιά του μενού. 

4.3.5. Εισαγωγή συνθηκών στήριξης 

 Geometry > Supports: Υπάρχουν έτοιμες οι επιλογές Pinned και Fixed που μπορούμε να τις 

χρησιμοποιήσουμε για την τοποθέτηση άρθρωσης ή πάκτωσης αντίστοιχα. Για τη δημιουργία 

καινούριου τύπου στήριξης μπορούμε να επιλέξουμε, από τη λίστα των μενού, New και να 

εισάγουμε σε αυτόν τους βαθμούς ελευθερίας που θέλουμε, καθώς και τις ιδιότητές του. 

4.3.6. Εισαγωγή φορτίων 

 Loads > Load Types: Ορίζουμε τους τύπους φορτίων που θέλουμε να εισάγουμε στο μοντέλο μας. 

Εισάγουμε ένα ΜΟΝΙΜΟ φορτίο για το ίδιο βάρος και ένα δεύτερο ΜΟΝΙΜΟ φορτίο που θα 

μπορούσε να είναι ένα συγκεντρωμένο φορτίο. Ομοίως για άλλους τύπους μόνιμων φορτίων. 

 Loads > Load Definitions: Αρχικά επιλέγουμε τον τύπο φορτίου που δημιουργήσαμε προηγουμένως 

και στον οποίο θέλουμε να αποδώσουμε κάποιο φορτίο. Σε όλα μας τα μοντέλα εισάγουμε το ίδιο 
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βάρος της κατασκευής ως εξής, επιλέγουμε τον τύπο του ίδιου βάρους και έπειτα πάμε στην 

καρτέλα Self-weight and mass του μενού. Εκεί πατώντας το κουμπί Self-weight -PZ for the whole 

structure εφαρμόζουμε το ίδιο βάρος σε όλη την κατασκευή. Για επιβολή συγκεντρωμένου φορτίου, 

αφού έχουμε επιλέξει τον αντίστοιχο τύπο φορτίου, πηγαίνουμε στην καρτέλα Bar του μενού. Εκεί 

πατώντας το κουμπί Bar force εφαρμόζουμε τη δύναμη ή τη ροπή που θέλουμε σε όποιο σημείο 

μίας ράβδου και σε όποια κατεύθυνση θέλουμε. Αν θέλουμε να το επιβάλλουμε σε συγκεκριμένο 

κόμβο προχωράμε αντίστοιχα στην καρτέλα Node και έπειτα στο κουμπί Nodal Force. Για επιβολή 

κατανεμημένου φορτίου, μετά την επιλογή επίσης του αντίστοιχου τύπου φορτίου, πηγαίνουμε 

στην καρτέλα Bar του μενού. Εκεί με το κουμπί Uniform Load εφαρμόζουμε το φορτίο, για το οποίο 

ορίζουμε τον άξονα της διεύθυνσής του και τη γωνία πάνω σε αυτόν, καθώς και το αν θα ασκείται 

κατά μήκος του στοιχείου ή κατά μήκος της οριζόντιας προβολής του. 

 Analysis > Analysis Types: Στην καρτέλα Analysis Types εμφανίζονται οι τύποι φορτίων που έχουμε 

εισάγει. Επιλέγοντας το κάθε ένα και πατώντας το κουμπί Parameters αλλάζουμε χαρακτηριστικά 

ως προς τη γεωμετρική μη γραμμικότητα. Τροποποιούμε επίσης τις Nonlinear analysis parameters. 

Για το ίδιο βάρος θέλουμε το Load Increment Number να είναι ίσο με τη μονάδα έτσι, ώστε να 

ασκηθεί σε ένα βήμα, ενώ για κάποιο άλλο τύπο φορτίου επιλέγουμε να ασκείται σε επιθυμητό κάθε 

φορά αριθμό βημάτων. Σαν μέθοδο άσκησης του φορτίου επιλέγουμε την Incremental Method, 

ενώ σαν μέθοδο ανάλυσης ακολουθούμε τη Full Newton-Raphson οπότε ενεργοποιούμε τις επιλογές 

Matrix update after each subdivision και Matrix update after each iteration. Αξίζει να σημειωθεί εδώ 

ότι αν θέλαμε να ακολουθήσουμε την Modified Newton-Raphson θα ενεργοποιούσαμε μόνο την 

πρώτη επιλογή. Τέλος, για να μπορέσουμε να εξάγουμε γραφήματα πρέπει να έχουμε τα επιθυμητά 

μεγέθη σε κάθε βήμα της ανάλυσης οπότε επιλέγουμε αποθήκευση αποτελεσμάτων σε κάθε βήμα 

μέσω του Save results after each increment. Στο κελί Maximum iteration number for one increment 

εισάγουμε τον αριθμό των επαναλήψεων που θέλουμε να γίνουν μέχρι να επιτευχθεί το επιθυμητό 

στάδιο ισορροπίας. Σε περίπτωση μη σύγκλισης το λογισμικό αυτόματα μειώνει στο μισό το ρυθμό 

αύξησης του φορτίου, δηλαδή αυξάνει στο διπλάσιο τα βήματα κατά τα οποία εφαρμόζεται το 

φορτίο, κάτι που το εισάγουμε στο κελί Increment length reduction factor. Αυτή η διαδικασία 

επαναλαμβάνεται τόσες φορές όσες ορίσουμε στο κελί Increment length reduction number. Οι 

επιλογές αυτές υποδεικνύονται στην Εικόνα 4-3. 
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Εικόνα 4-3: Τρόπος επιλογής μεθόδου Full Newton-Raphson στο περιβάλλον του ROBOT [6] 

4.3.7. Επίλυση μοντέλου 

 Analysis > Calculations: Το λογισμικό τρέχει την ανάλυση που έχουμε ορίσει και εξάγει τα 

αποτελέσματα. 

4.3.8. Παρουσίαση αποτελεσμάτων 

 Results > Diagrams for Bars: Στα μοντέλα που θα αναλυθούν εμφανίζουμε τις αντιδράσεις στις 

στηρίξεις, την αξονική ένταση του καλωδίου καθώς και τις μετακινήσεις. Μπορούμε να εμφανίσουμε 

τις τιμές των παραπάνω μεγεθών στο περιβάλλον σε κάθε βήμα της ανάλυσης πατώντας το κουμπί 

 με όνομα Select Component. Έχοντας επιλεγμένη τη φόρτιση από το συγκεντρωμένο φορτίο 

πατάμε το κουμπί που αναφέραμε. Από το μενού που ανοίγει επιλέγουμε το βήμα στο οποίο θέλουμε 

να εμφανίσουμε τα μεγέθη στο περιβάλλον μας. Πρέπει να σημειωθεί ότι για Current component 

ίσο με 1 εμφανίζονται αποτελέσματα για άσκηση του πλήρους φορτίου, ενώ για Current component 

ίσο με τον αριθμό του τελευταίου βήματος εμφανίζονται αποτελέσματα για άσκηση του πρώτου 

τμήματος του φορτίου. 

 Results > Advanced > Diagrams: Δημιουργούμε τους δρόμους ισορροπίας, δηλαδή γραφήματα που 

μας δείχνουν την αντιστοιχία μεταξύ δύο μεγεθών. Στο υπομενού Function definition πατώντας Add 
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επιλέγουμε τα μεγέθη που θέλουμε να εμφανιστούν στα διαγράμματα. Για παράδειγμα, αν θέλουμε 

το διάγραμμα μετακίνησης-φορτίου για το μέσο ενός μεμονωμένου καλωδίου, προσθέτουμε τη 

συνάρτηση Nodal Displacement για μετακίνηση UZ για τον κόμβο του μέσου και τη συνάρτηση 

Reaction Sum για δυνάμεις FZ, που μας παρουσιάζει το άθροισμα των κατακόρυφων αντιδράσεων 

στο μοντέλο το οποίο αντιστοιχεί στο επιβεβλημένο φορτίο και το ίδιο βάρος της κατασκευής. 

Τοποθετώντας λοιπόν ένα μέγεθος σε κάθε άξονα εμφανίζουμε το γράφημά μας.





 

 ΣΥΓΚΡΙΣΗ ΕΝΑΛΛΑΚΤΙΚΩΝ ΤΡΟΠΩΝ ΑΝΑΛΥΣΗΣ ΚΑΛΩΔΙΩΤΩΝ ΚΑΤΑΣΚΕΥΩΝ  

5. ΜΕΜΟΝΩΜΕΝΟ ΚΑΛΩΔΙΟ ΧΩΡΙΣ ΚΡΕΜΑΣΗ 

Σε αυτό το κεφάλαιο όπως και στα 6,7,8 και 9 πραγματοποιείται περαιτέρω ανάλυση της διαδικασίας 

προσομοίωσης των μοντέλων σε κάθε επιμέρους λογισμικό λόγω πρόσθετων βημάτων που απαιτούνται 

κατά τη μοντελοποίηση, την ανάλυση και την επεξεργασία και παρουσίαση των αποτελεσμάτων. Επίσης 

συγκρίνονται τα αποτελέσματα μεταξύ των λογισμικών και παραθέτονται σύντομα συμπεράσματα. 

5.1. ΠΡΟΣΟΜΟΙΩΣΗ ΜΕ ΤΟ ADINA 

5.1.1. Γεωμετρία φορέα 

 Geometry > Points: Επιθυμούμε το άνοιγμα της απόστασης που θέλουμε να καλύψουμε να είναι 

6m οπότε ορίζουμε δύο σημεία με συντεταγμένες (0,0,0) και (6,0,0) ακολουθώντας τη διαδικασία 

που περιγράφηκε στο κεφάλαιο 0. 

 Geometry > Lines > Define: Ενώνουμε τα παραπάνω σημεία με μία γραμμή τύπου Straight που θα 

αποτελέσει το καλώδιό μας. Ο φορέας που προκύπτει μετά από τη διακριτοποίηση και την 

τοποθέτηση των στοιχείων προσομοίωσης, που περιγράφεται παρακάτω, φαίνεται στην Εικόνα 5-1. 

 

Εικόνα 5-1: Φορέας μεμονωμένου καλωδίου στο περιβάλλον του ADINA [7] 

5.1.2. Δημιουργία στοιχείων προσομοίωσης και διακριτοποίηση 

Όσον αφορά τον τρόπο διακριτοποίησης στο συγκεκριμένο μοντέλο, ορίσαμε να γίνει με συγκεκριμένο 

μήκος τμημάτων του καλωδίου, και πιο συγκεκριμένα επιλέξαμε να διακριτοποιηθεί ανά 1m. Έτσι 

προέκυψαν 6 τμήματα του ενός μέτρου. Το ίδιο αποτέλεσμα θα είχαμε επιλέγοντας συγκεκριμένο αριθμό 

ίσων τμημάτων για το στοιχείο μας και ορίζοντάς το να αποτελείται από 6 τμήματα. Στις περιπτώσεις 

ωστόσο που ασκούμε κατανεμημένο φορτίο ορίσαμε τη διαίρεση του καλωδίου σε 100 τμήματα για την 

άσκηση του φορτίου ως σημειακά φορτία σε κάθε έναν από τους κόμβους που προκύπτουν. Η διαδικασία 

περιγράφηκε αναλυτικά στο κεφάλαιο 4.1.7. 

5.1.3. Εισαγωγή φορτίων 

 Control > Time Function: Προσθέτουμε δύο καινούρια Time Functions, ένα για το ίδιο βάρος και 

ένα για το φορτίο μας, έστω το συγκεντρωμένο φορτίο. Θέλουμε να ασκείται αρχικά και εξ’ 
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ολοκλήρου το ίδιο βάρος μαζί με την προένταση και στη συνέχεια σε βήματα το συγκεντρωμένο 

φορτίο. Ο Πίνακας 5-1 παρουσιάζει τα Time Functions που ορίστηκαν. 

Πίνακας 5-1: Ορισμός Time Functions για την επιβολή των φορτίων σε συγκεκριμένο χρόνο και βήματα 

ΙΔΙΟ ΒΑΡΟΣ  ΣΥΓΚΕΝΤΡΩΜΕΝΟ ΦΟΡΤΙΟ 

Time Value  Time Value 

0.00 0.00  0.00 0.00 

0.01 1.00  0.01 0.00 

1.01 1.00  1.01 1.00 

Ορίζουμε λοιπόν, όσον αφορά το ίδιο βάρος, να επιβάλλεται στο σύνολό του από χρόνο 0.00 έως 

0.01 με βήμα 0.01, που το ορίσαμε στο παραπάνω μενού, οπότε επιβάλλεται σε ένα βήμα. Για το 

συγκεντρωμένο φορτίο από την άλλη ορίζουμε να ασκείται από χρόνο 0.01 έως 1.01 με βήμα επίσης 

0.01. Αυτό σημαίνει ότι θα ασκηθεί αφού έχει ασκηθεί το ίδιο βάρος και η προένταση, και θα ασκηθεί 

σε 100 βήματα. Ίδια διαδικασία ακολουθήθηκε και για το κατανεμημένο φορτίο κατά μήκος του 

τόξου και κατά μήκος της οριζόντιας προβολής του καλωδίου. 

5.2. ΠΡΟΣΟΜΟΙΩΣΗ ΜΕ SAP2000 & ROBOT 

Παρακάτω παρατίθενται οι  και  που μας δείχνουν την τελική γεωμετρία των φορέων στα λογισμικά 

SAP2000 και ROBOT. 

 

Εικόνα 5-2: Φορέας μεμονωμένου καλωδίου στο περιβάλλον του SAP2000 [4] 

 

Εικόνα 5-3: Φορέας μεμονωμένου καλωδίου στο περιβάλλον του ROBOT [6] 

5.3. ΣΥΓΚΡΙΣΗ ΑΠΟΤΕΛΕΣΜΑΤΩΝ 

Σε αυτό το κεφάλαιο παρατίθενται γραφήματα για σύγκριση μεγεθών στα τρία λογισμικά. Τα μεγέθη 

που θα δούμε είναι η μετακίνηση στο μέσο του καλωδίου σε σχέση με την αξονική ένταση και το 

επιβαλλόμενο φορτίο και την αξονική ένταση σε σχέση με το επιβαλλόμενο φορτίο. Εμφανίζονται επίσης 

ραβδογράμματα που παρουσιάζουν τι τάξεως διαφορά έχουμε μεταξύ των αποτελεσμάτων. Για την 

εξαγωγή των τελευταίων υπολογίσαμε τους λόγους ανάμεσα στα αποτελέσματα των λογισμικών, σε 

κάθε βήμα, και στη συνέχεια εξήγαμε ένα μέσο όρο αυτών των όρων, οι οποίοι και παρουσιάζονται. 
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5.3.1. Περίπτωση συγκεντρωμένου φορτιού στο μέσο 

 

Σχήμα 5-1: Ένταση καλωδίου χωρίς κρέμαση υπό συγκεντρωμένο φορτίο ως συνάρτηση της παραμόρφωσης 

 

Σχήμα 5-2: Δρόμος ισορροπίας για καλώδιο χωρίς κρέμαση υπό συγκεντρωμένο φορτίο 



30  ΚΕΦΑΛΑΙΟ 5 

ΜΕΤΑΠΤΥΧΙΑΚΗ ΕΡΓΑΣΙΑ ΤΟΥ ΔΗΜΗΤΡΙΟΥ ΠΑΠΑΔΟΓΙΑΝΝΑΚΗ Ε.Μ.Π. - 2020 

 

Σχήμα 5-3: Ένταση καλωδίου χωρίς κρέμαση υπό συγκεντρωμένο φορτίο ως συνάρτηση του φορτίου 

 

Σχήμα 5-4: Ομοιότητες μεταξύ αποτελεσμάτων στην παραμόρφωση κατά την άσκηση συγκεντρωμένου φορτίου 
σε καλώδιο χωρίς κρέμαση 
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Σχήμα 5-5: Λεπτομέρεια από το Σχήμα 5-4 

 

Σχήμα 5-6: Ομοιότητες μεταξύ αποτελεσμάτων στην ένταση κατά την άσκηση συγκεντρωμένου φορτίου σε 
καλώδιο χωρίς κρέμαση 
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Σχήμα 5-7: Λεπτομέρεια από το Σχήμα 5-6 

5.3.2. Περίπτωση κατανεμημένου φορτίου κατά μήκος του τόξου 

 

Σχήμα 5-8: Ένταση καλωδίου χωρίς κρέμαση υπό κατανεμημένο φορτίο κατά μήκος του τόξου ως συνάρτηση της 
παραμόρφωσης 
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Σχήμα 5-9: Δρόμος ισορροπίας για καλώδιο χωρίς κρέμαση υπό κατανεμημένο φορτίο κατά μήκος του τόξου 

 

Σχήμα 5-10: Ένταση καλωδίου χωρίς κρέμαση υπό κατανεμημένο φορτίο κατά μήκος του τόξου ως συνάρτηση 
του φορτίου 



34  ΚΕΦΑΛΑΙΟ 5 

ΜΕΤΑΠΤΥΧΙΑΚΗ ΕΡΓΑΣΙΑ ΤΟΥ ΔΗΜΗΤΡΙΟΥ ΠΑΠΑΔΟΓΙΑΝΝΑΚΗ Ε.Μ.Π. - 2020 

 

Σχήμα 5-11: Ομοιότητες μεταξύ αποτελεσμάτων στην παραμόρφωση κατά την άσκηση κατανεμημένου φορτίου 
κατά μήκος του τόξου σε καλώδιο χωρίς κρέμαση 

 

Σχήμα 5-12: Λεπτομέρεια από το Σχήμα 5-11 
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Σχήμα 5-13: Ομοιότητες μεταξύ αποτελεσμάτων στην ένταση κατά την άσκηση κατανεμημένου φορτίου κατά 
μήκος του τόξου σε καλώδιο χωρίς κρέμαση 

 

Σχήμα 5-14: Λεπτομέρεια από το Σχήμα 5-13 
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5.3.3. Περίπτωση κατανεμημένου φορτίου κατά μήκος της οριζόντιας προβολής 

 

Σχήμα 5-15: Ένταση καλωδίου χωρίς κρέμαση υπό κατανεμημένο φορτίο κατά μήκος της οριζόντιας προβολής ως 
συνάρτηση της παραμόρφωσης 

 

Σχήμα 5-16: Δρόμος ισορροπίας για καλώδιο χωρίς κρέμαση υπό κατανεμημένο φορτίο κατά μήκος της οριζόντιας 
προβολής 
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Σχήμα 5-17: Ένταση καλωδίου χωρίς κρέμαση υπό κατανεμημένο φορτίο κατά μήκος της οριζόντιας προβολής ως 
συνάρτηση του φορτίου 

 

Σχήμα 5-18: Ομοιότητες μεταξύ αποτελεσμάτων στην παραμόρφωση κατά την άσκηση κατανεμημένου φορτίου 
κατά μήκος της οριζόντιας προβολής σε καλώδιο χωρίς κρέμαση 
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Σχήμα 5-19: Λεπτομέρεια από το Σχήμα 5-18 

 

Σχήμα 5-20: Ομοιότητες μεταξύ αποτελεσμάτων στην ένταση κατά την άσκηση κατανεμημένου φορτίου κατά 
μήκος της οριζόντιας προβολής σε καλώδιο χωρίς κρέμαση 
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Σχήμα 5-21:Λεπτομέρεια από το Σχήμα 5-20 

5.3.4. Συμπέρασμα 

Παρατηρούμε λοιπόν ότι στην απλή περίπτωση του καλωδίου χωρίς κρέμαση τα τρία λογισμικά 

συμφωνούν σε πολύ μεγάλο βαθμό ως προς τα αποτελέσματά τους στην επιβολή κάθε μίας από τις τρεις 

περιπτώσεις φόρτισης.





 

 ΣΥΓΚΡΙΣΗ ΕΝΑΛΛΑΚΤΙΚΩΝ ΤΡΟΠΩΝ ΑΝΑΛΥΣΗΣ ΚΑΛΩΔΙΩΤΩΝ ΚΑΤΑΣΚΕΥΩΝ  

6. ΜΕΜΟΝΩΜΕΝΟ ΚΑΛΩΔΙΟ ΜΕ ΚΡΕΜΑΣΗ 

6.1. ΠΡΟΣΟΜΟΙΩΣΗ ΜΕ ΤΟ ADINA 

6.1.1. Γεωμετρία φορέα 

 Geometry > Points: Πέρα από την εισαγωγή των σημείων όπως έγινε στο κεφάλαιο 5.1, εισάγουμε 

ακόμα ένα σημείο στη θέση όπου θα βρίσκεται το μέσο του καλωδίου στην απαραμόρφωτη 

κατάστασή του, με μήκος S0. Ο τρόπος υπολογισμού της τεταγμένης αυτού του σημείου γίνεται 

από την Εξ. (6-1) που αποτελεί εξίσωση παραβολής. 

x2=2∙p∙ψ (6-1) 

Τα σημεία λοιπόν που προκύπτουν για κάθε περίπτωση αρχικού μήκους είναι τα εξής: 

o Για S0=1.05×L και p=5.38379 προκύπτει για x=3, ψ=0.83584246531131, που είναι η 

κατακόρυφη απόσταση από το κατώτερο σημείο στα δύο ανώτερα σημεία του καλωδίου. 

o Για S0=1.10×L και p=3.74437 προκύπτει για x=3, ψ=1.20180552310275. 

o Για S0=1.15×L και p=3.00838 προκύπτει για x=3, ψ=1.49582063237508. 

 Geometry > Lines > Define: Τα παραπάνω σημεία τα ενώσουμε αυτή τη φορά με μία γραμμή τύπου 

Arc. Αυτό γίνεται επιλέγοντας αρχικά τα δύο άκρα του και στη συνέχεια το σημείο του μέσου του. 

Ο φορέας που προκύπτει μετά από τη διακριτοποίηση και την τοποθέτηση των στοιχείων 

προσομοίωσης, που περιγράφεται παρακάτω, φαίνεται στην  

 

Εικόνα 6-1: Φορέας καλωδίου με κρέμαση στο περιβάλλον του ADINA [7] 
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6.1.2. Δημιουργία στοιχείων προσομοίωσης και διακριτοποίηση 

Στην περίπτωση φόρτισης με συγκεντρωμένο φορτίο στο μέσο επιλέγουμε να διαιρέσουμε το καλώδιό 

μας σε 20 τμήματα για μεγαλύτερη προσέγγιση της καμπύλης με ευθύγραμμα τμήματα. Αυτό γίνεται 

καθώς το ADINA κατά τη διακριτοποίηση και την τοποθέτηση των στοιχείων προσομοίωσης πάνω στην 

καμπύλη γραμμή , το πραγματοποιεί με ευθύγραμμα στοιχεία. Στις περιπτώσεις όμως με το 

κατανεμημένο φορτίο η διαίρεση γίνεται σε 100 τμήματα για το λόγο που εξηγήθηκε και στο κεφάλαιο 

5.1.2. 

6.1.3. Εισαγωγή φορτίων 

 Control > Time Function: Στις περιπτώσεις των μοντέλων με καλώδιο με κρέμαση δεν επιτυγχάνεται 

σύγκλιση. Έτσι οδηγούμαστε σε αύξηση του αριθμού των βημάτων σε 1000 ακολουθώντας τη 

διαδικασία που περιγράφηκε στο κεφάλαιο 4.1.7. Πέρα από αυτό προχωρήσαμε και σε μεταβολή 

των αντίστοιχων Time Functions. Ο Πίνακας 6-1 παρουσιάζει την αλλαγή που πραγματοποιήθηκε. 

Στα μοντέλα με S0=1.10×L και S0=1.15×L δεν επιτυγχάνεται σύγκλιση ούτε με την αύξηση των 

βημάτων οπότε καταλήξαμε στην επιλογή του Automatic Time Stepping. 

Πίνακας 6-1: Ορισμός Time Function για επιβολή φορτίου σε 1000 βήματα 

ΙΔΙΟ ΒΑΡΟΣ  ΣΥΓΚΕΝΤΡΩΜΕΝΟ ΦΟΡΤΙΟ 

Time Value  Time Value 

0.000 0.000  0.000 0.000 

0.001 1.000  0.001 0.000 

1.001 1.000  1.001 1.000 

6.2. ΠΡΟΣΟΜΟΙΩΣΗ ΜΕ ΤΟ SAP2000 

Η τελική γεωμετρία καλωδίου με κρέμαση όσον αφορά το λογισμικό SAP2000 εμφανίζεται στην Εικόνα 

6-2. 

 

Εικόνα 6-2: Φορέας καλωδίου με κρέμαση στο περιβάλλον του SAP2000 [4] 

6.3. ΠΡΟΣΟΜΟΙΩΣΗ ΜΕ ΤΟ ROBOT 

Η τελική γεωμετρία καλωδίου με κρέμαση όπως προέκυψε στο λογισμικό ROBOT παρουσιάζεται στην 

Εικόνα 6-3. 
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Εικόνα 6-3: Φορέας καλωδίου με κρέμαση στο περιβάλλον του ROBOT [6] 

6.3.1. Δημιουργία στοιχείων προσομοίωσης και διακριτοποίηση 

 Geometry > Objects > Arc: Στην περίπτωση καλωδίου με κρέμαση δεν θέλουμε να τοποθετήσουμε 

το καλώδιο σαν ευθεία γραμμή. Έτσι το μενού αυτό μας βοηθάει να εισάγουμε την αρχική του 

γεωμετρία, όταν δηλαδή είναι αφόρτιστο, με μήκος S0.και κρέμαση που υπολογίζεται γεωμετρικά 

όπως αναφέρθηκε και στο κεφάλαιο 6.1. Ορίζουμε το καλώδιο επιλέγοντας τα δύο του άκρα και το 

μέσον του στο ύψος που έχει υπολογιστεί. Παράλληλα με αυτή τη διαδικασία γίνεται διακριτοποίηση 

και δημιουργούνται τα στοιχεία προσομοίωσης επιλέγοντας από το υπομενού Arc discretization να 

διαιρεθεί σε 100 ίσα τμήματα και να δημιουργηθούν bars elements μέσω της επιλογής Create bars. 

6.4. ΣΥΓΚΡΙΣΗ ΑΠΟΤΕΛΕΣΜΑΤΩΝ 

6.4.1. Περίπτωση S0=1.05×L 

6.4.1.1. Περίπτωση συγκεντρωμένου φορτίου στο μέσο 

 

Σχήμα 6-1: Ένταση καλωδίου με κρέμαση (S0=1.05×L) υπό συγκεντρωμένο φορτίο ως συνάρτηση της 
παραμόρφωσης 
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Σχήμα 6-2: Δρόμος ισορροπίας για καλώδιο με κρέμαση (S0=1.05×L) υπό συγκεντρωμένο φορτίο 

 

Σχήμα 6-3: Ένταση καλωδίου με κρέμαση (S0=1.05×L) υπό συγκεντρωμένο φορτίο ως συνάρτηση του φορτίου 
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Σχήμα 6-4: Ομοιότητες μεταξύ αποτελεσμάτων στην παραμόρφωση κατά την άσκηση συγκεντρωμένου φορτίου 
σε καλώδιο με κρέμαση (S0=1.05×L) 

 

Σχήμα 6-5: Λεπτομέρεια από το Σχήμα 6-4 
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Σχήμα 6-6: Ομοιότητες μεταξύ αποτελεσμάτων στην ένταση κατά την άσκηση συγκεντρωμένου φορτίου σε 
καλώδιο με κρέμαση (S0=1.05×L) 

 

Σχήμα 6-7: Λεπτομέρεια από το Σχήμα 6-6 
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6.4.1.2. Περίπτωση κατανεμημένου φορτίου κατά μήκος του τόξου 

 

Σχήμα 6-8: Ένταση καλωδίου με κρέμαση (S0=1.05×L) υπό κατανεμημένο φορτίο κατά μήκος του τόξου ως 
συνάρτηση της παραμόρφωσης 

 

Σχήμα 6-9: Δρόμος ισορροπίας για καλώδιο με κρέμαση (S0=1.05×L) υπό κατανεμημένο φορτίο κατά μήκος του 
τόξου 
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Σχήμα 6-10: Ένταση καλωδίου με κρέμαση (S0=1.05×L) υπό κατανεμημένο φορτίο κατά μήκος του τόξου ως 
συνάρτηση του φορτίου 

 

Σχήμα 6-11: Ομοιότητες μεταξύ αποτελεσμάτων στην παραμόρφωση κατά την άσκηση κατανεμημένου φορτίου 
κατά μήκος του τόξου σε καλώδιο με κρέμαση (S0=1.05×L) 
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Σχήμα 6-12: Λεπτομέρεια από το Σχήμα 6-11 

 

Σχήμα 6-13: Ομοιότητες μεταξύ αποτελεσμάτων στην ένταση κατά την άσκηση κατανεμημένου φορτίου κατά 
μήκος του τόξου σε καλώδιο με κρέμαση (S0=1.05×L) 
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Σχήμα 6-14: Λεπτομέρεια από το Σχήμα 6-13 

6.4.1.3. Περίπτωση κατανεμημένου φορτίου κατά μήκος της οριζόντιας προβολής 

 

Σχήμα 6-15: Ένταση καλωδίου με κρέμαση (S0=1.05×L) υπό κατανεμημένο φορτίο κατά μήκος της οριζόντιας 
προβολής ως συνάρτηση της παραμόρφωσης 
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Σχήμα 6-16: Δρόμος ισορροπίας για καλώδιο με κρέμαση (S0=1.05×L) υπό κατανεμημένο φορτίο κατά μήκος της 
οριζόντιας προβολής 

 

Σχήμα 6-17: Ένταση καλωδίου με κρέμαση (S0=1.05×L) υπό κατανεμημένο φορτίο κατά μήκος της οριζόντιας 
προβολής ως συνάρτηση του φορτίου 
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Σχήμα 6-18: Ομοιότητες μεταξύ αποτελεσμάτων στην παραμόρφωση κατά την άσκηση κατανεμημένου φορτίου 
κατά μήκος της οριζόντιας προβολής σε καλώδιο με κρέμαση (S0=1.05×L) 

 

Σχήμα 6-19: Λεπτομέρεια από το Σχήμα 6-18 
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Σχήμα 6-20: Ομοιότητες μεταξύ αποτελεσμάτων στην ένταση κατά την άσκηση κατανεμημένου φορτίου κατά 
μήκος της οριζόντιας προβολής σε καλώδιο με κρέμαση (S0=1.05×L) 

 

Σχήμα 6-21: Λεπτομέρεια από το Σχήμα 6-20 
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6.4.2. Περίπτωση S0=1.10×L 

6.4.2.1. Περίπτωση συγκεντρωμένου φορτίου στο μέσο 

 

Σχήμα 6-22: Ένταση καλωδίου με κρέμαση (S0=1.10×L) υπό συγκεντρωμένο φορτίο ως συνάρτηση της 
παραμόρφωσης 

 

Σχήμα 6-23: Δρόμος ισορροπίας για καλώδιο με κρέμαση (S0=1.10×L) υπό συγκεντρωμένο φορτίο 
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Σχήμα 6-24: Ένταση καλωδίου με κρέμαση (S0=1.10×L) υπό συγκεντρωμένο φορτίο ως συνάρτηση του φορτίου 

 

Σχήμα 6-25: Ομοιότητες μεταξύ αποτελεσμάτων στην παραμόρφωση κατά την άσκηση συγκεντρωμένου φορτίου 
σε καλώδιο με κρέμαση (S0=1.10×L) 
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Σχήμα 6-26: Λεπτομέρεια από το Σχήμα 6-25 

 

Σχήμα 6-27: Ομοιότητες μεταξύ αποτελεσμάτων στην ένταση κατά την άσκηση συγκεντρωμένου φορτίου σε 
καλώδιο με κρέμαση (S0=1.10×L) 
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Σχήμα 6-28: Λεπτομέρεια από το Σχήμα 6-27 

6.4.2.2. Περίπτωση κατανεμημένου φορτίου κατά μήκος του τόξου 

 

Σχήμα 6-29: Ένταση καλωδίου με κρέμαση (S0=1.10×L) υπό κατανεμημένο φορτίο κατά μήκος του τόξου ως 
συνάρτηση της παραμόρφωσης 
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Σχήμα 6-30: Δρόμος ισορροπίας για καλώδιο με κρέμαση (S0=1.10×L) υπό κατανεμημένο φορτίο κατά μήκος του 
τόξου 

 

Σχήμα 6-31: Ένταση καλωδίου με κρέμαση (S0=1.10×L) υπό κατανεμημένο φορτίο κατά μήκος του τόξου ως 
συνάρτηση του φορτίου 
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Σχήμα 6-32: Ομοιότητες μεταξύ αποτελεσμάτων στην παραμόρφωση κατά την άσκηση κατανεμημένου φορτίου 
κατά μήκος του τόξου σε καλώδιο με κρέμαση (S0=1.10×L) 

 

Σχήμα 6-33: Λεπτομέρεια από το Σχήμα 6-32 
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Σχήμα 6-34: Ομοιότητες μεταξύ αποτελεσμάτων στην ένταση κατά την άσκηση κατανεμημένου φορτίου κατά 
μήκος του τόξου σε καλώδιο με κρέμαση (S0=1.10×L) 

 

Σχήμα 6-35: Λεπτομέρεια από το Σχήμα 6-34 
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6.4.2.3. Περίπτωση κατανεμημένου φορτίου κατά μήκος της οριζόντιας προβολής 

 

Σχήμα 6-36: Ένταση καλωδίου με κρέμαση (S0=1.10×L) υπό κατανεμημένο φορτίο κατά μήκος της οριζόντιας 
προβολής ως συνάρτηση της παραμόρφωσης 

 

Σχήμα 6-37: Δρόμος ισορροπίας για καλώδιο με κρέμαση (S0=1.10×L) υπό κατανεμημένο φορτίο κατά μήκος της 
οριζόντιας προβολής 
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Σχήμα 6-38: Ένταση καλωδίου με κρέμαση (S0=1.10×L) υπό κατανεμημένο φορτίο κατά μήκος της οριζόντιας 
προβολής ως συνάρτηση του φορτίου 

 

Σχήμα 6-39: Ομοιότητες μεταξύ αποτελεσμάτων στην παραμόρφωση κατά την άσκηση κατανεμημένου φορτίου 
κατά μήκος της οριζόντιας προβολής σε καλώδιο με κρέμαση (S0=1.10×L) 
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Σχήμα 6-40: Λεπτομέρεια από το Σχήμα 6-39 

 

Σχήμα 6-41: Ομοιότητες μεταξύ αποτελεσμάτων στην ένταση κατά την άσκηση κατανεμημένου φορτίου κατά 
μήκος της οριζόντιας προβολής σε καλώδιο με κρέμαση (S0=1.10×L) 
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Σχήμα 6-42: Λεπτομέρεια από το Σχήμα 6-41 

6.4.3. Περίπτωση S0=1.15×L 

6.4.3.1. Περίπτωση συγκεντρωμένου φορτίου στο μέσο 

 

Σχήμα 6-43: Ένταση καλωδίου με κρέμαση (S0=1.15×L) υπό συγκεντρωμένο φορτίο ως συνάρτηση της 
παραμόρφωσης 
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Σχήμα 6-44: Δρόμος ισορροπίας για καλώδιο με κρέμαση (S0=1.15×L) υπό συγκεντρωμένο φορτίο 

 

Σχήμα 6-45: Ένταση καλωδίου με κρέμαση (S0=1.15×L) υπό συγκεντρωμένο φορτίο ως συνάρτηση του φορτίου 
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Σχήμα 6-46: Ομοιότητες μεταξύ αποτελεσμάτων στην παραμόρφωση κατά την άσκηση συγκεντρωμένου φορτίου 
σε καλώδιο με κρέμαση (S0=1.15×L) 

 

Σχήμα 6-47: Λεπτομέρεια από το Σχήμα 6-46 



ΜΕΜΟΝΩΜΕΝΟ ΚΑΛΩΔΙΟ ΜΕ ΚΡΕΜΑΣΗ  67 

 

 

Σχήμα 6-48: Ομοιότητες μεταξύ αποτελεσμάτων στην ένταση κατά την άσκηση συγκεντρωμένου φορτίου σε 
καλώδιο με κρέμαση (S0=1.15×L) 

 

Σχήμα 6-49: Λεπτομέρεια από το Σχήμα 6-48 
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6.4.3.2. Περίπτωση κατανεμημένου φορτίου κατά μήκος του τόξου 

 

Σχήμα 6-50: Ένταση καλωδίου με κρέμαση (S0=1.15×L) υπό κατανεμημένο φορτίο κατά μήκος του τόξου ως 
συνάρτηση της παραμόρφωσης 

 

Σχήμα 6-51: Δρόμος ισορροπίας για καλώδιο με κρέμαση (S0=1.15×L) υπό κατανεμημένο φορτίο κατά μήκος του 
τόξου 
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Σχήμα 6-52: Ένταση καλωδίου με κρέμαση (S0=1.15×L) υπό κατανεμημένο φορτίο κατά μήκος του τόξου ως 
συνάρτηση του φορτίου 

 

Σχήμα 6-53: Ομοιότητες μεταξύ αποτελεσμάτων στην παραμόρφωση κατά την άσκηση κατανεμημένου φορτίου 
κατά μήκος του τόξου σε καλώδιο με κρέμαση (S0=1.15×L) 



70  ΚΕΦΑΛΑΙΟ 6 

ΜΕΤΑΠΤΥΧΙΑΚΗ ΕΡΓΑΣΙΑ ΤΟΥ ΔΗΜΗΤΡΙΟΥ ΠΑΠΑΔΟΓΙΑΝΝΑΚΗ Ε.Μ.Π. - 2020 

 

Σχήμα 6-54: Λεπτομέρεια από το Σχήμα 6-53 

 

Σχήμα 6-55: Ομοιότητες μεταξύ αποτελεσμάτων στην ένταση κατά την άσκηση κατανεμημένου φορτίου κατά 
μήκος του τόξου σε καλώδιο με κρέμαση (S0=1.15×L) 
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Σχήμα 6-56: Λεπτομέρεια από το Σχήμα 6-55 

6.4.3.3. Περίπτωση κατανεμημένου φορτίου κατά μήκος της οριζόντιας προβολής 

 

Σχήμα 6-57: Ένταση καλωδίου με κρέμαση (S0=1.15×L) υπό κατανεμημένο φορτίο κατά μήκος της οριζόντιας 
προβολής ως συνάρτηση της παραμόρφωσης 
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Σχήμα 6-58: Δρόμος ισορροπίας για καλώδιο με κρέμαση (S0=1.15×L) υπό κατανεμημένο φορτίο κατά μήκος της 
οριζόντιας προβολής 

 

Σχήμα 6-59: Ένταση καλωδίου με κρέμαση (S0=1.15×L) υπό κατανεμημένο φορτίο κατά μήκος της οριζόντιας 
προβολής ως συνάρτηση του φορτίου 
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Σχήμα 6-60: Ομοιότητες μεταξύ αποτελεσμάτων στην παραμόρφωση κατά την άσκηση κατανεμημένου φορτίου 
κατά μήκος της οριζόντιας προβολής σε καλώδιο με κρέμαση (S0=1.15×L) 

 

Σχήμα 6-61: Λεπτομέρεια από το Σχήμα 6-60 
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Σχήμα 6-62: Ομοιότητες μεταξύ αποτελεσμάτων στην ένταση κατά την άσκηση κατανεμημένου φορτίου κατά 
μήκος της οριζόντιας προβολής σε καλώδιο με κρέμαση (S0=1.15×L) 

 

Σχήμα 6-63: Λεπτομέρεια από το Σχήμα 6-62 

6.4.4. Συμπέρασμα 

Παρατηρούμε ότι και για τις περιπτώσεις καλωδίου με κρέμαση, δηλαδή για τις διάφορες περιπτώσεις 

κρέμασης και φόρτισης, τα αποτελέσματα ανάμεσα στα τρία λογισμικά είναι πολύ κοντά. Παρατηρούμε 

όμως επίσης ότι όσο μεγαλώνει η κρέμαση, τόσο μεγαλύτερες διαφορές βλέπουμε ανάμεσα τους, με μία 

εξαίρεση ανάμεσα στα λογισμικά SAP2000 και ROBOT, όπου όμως οι διαφορές είναι ούτως ή άλλως πάρα 

πολύ μικρές. Αυτό γίνεται περισσότερο εμφανές στο Σχήμα 6-64 και στο Σχήμα 6-65, όπου 

παρουσιάζονται οι διαφορές για τις διάφορες κρεμάσεις όσον αφορά τα μοντέλα με το συγκεντρωμένο 

φορτίο στο μέσο.  
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Σχήμα 6-64: Αύξηση διαφοράς στη βύθιση ανάμεσα στα αποτελέσματα των τριών λογισμικών με την αύξηση της 
κρέμασης 

 

Σχήμα 6-65: Αύξηση διαφοράς στην αξονική ένταση ανάμεσα στα αποτελέσματα των τριών λογισμικών με την 
αύξηση της κρέμασης 





 

 ΣΥΓΚΡΙΣΗ ΕΝΑΛΛΑΚΤΙΚΩΝ ΤΡΟΠΩΝ ΑΝΑΛΥΣΗΣ ΚΑΛΩΔΙΩΤΩΝ ΚΑΤΑΣΚΕΥΩΝ  

7. ΕΠΙΤΟΝΟΣ ΙΣΤΟΣ 

7.1. ΠΡΟΣΟΜΟΙΩΣΗ ΜΕ ΤΟ ADINA 

7.1.1. Γεωμετρία φορέα 

Για τη δημιουργία του κορμού του ιστού εισήγαμε σε υψόμετρο 0 μέτρων τρία σημεία τα οποία 

υποδηλώνουν την τριγωνική κάτοψή του. Τα ίδια σημεία εισήγαμε και σε υψόμετρο 5 μέτρων, καθώς 

ανά 5 μέτρα παρουσιάζονται οριζόντια στοιχεία του δικτυώματος. Έπειτα ενώνουμε τα στοιχεία με 

γραμμές τύπου Straight. Πιο συγκεκριμένα, τραβάμε γραμμές μεταξύ των σημείων στα 5m που θα 

μετατραπούν σε οριζόντια στοιχεία, ενώνουμε τα σημεία μεταξύ των δύο υψομέτρων με κατακόρυφες 

γραμμές για τα κατακόρυφα στοιχεία και τέλος φέρνουμε και τις διαγωνίους μεταξύ τους για τα διαγώνια 

στοιχεία του δικτυώματος. Εισήγαμε επίσης τα σημεία που αγκυρώνονται τα καλώδια στο έδαφος σε 

αποστάσεις 20m και 40m από τις ακμές του ιστού για τα κάτω και τα πάνω καλώδια αντίστοιχα. Η τελική 

μορφή του μοντέλου φαίνεται και στην Εικόνα 7-1. 

 
 

(α) (β) 

Εικόνα 7-1: (α) Τρισδιάστατο μοντέλο και (β) κάτοψη μοντέλου στο περιβάλλον του ADINA [7] 

7.1.2. Δημιουργία διατομής 

Model > Cross Sections: Προσθέτουμε καινούριο τύπο διατομής, τόσο για τα οριζόντια στοιχεία του 

δικτυώματος, όσο και για τα κατακόρυφα και διαγώνια στοιχεία. Όσον αφορά τα οριζόντια στοιχεία, 

δημιουργούμε μια διατομή τύπου Pipe, και μεταβάλλουμε τα γεωμετρικά στοιχεία της στα επιθυμητά. 
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Για το συγκεκριμένο μοντέλο τα στοιχεία αυτά αναφέρονται στο κεφάλαιο 3.5.2. Για τα υπόλοιπα 

στοιχεία δημιουργήθηκε διατομή τύπου L-Beam στην οποία επίσης τροποποιήσαμε τα γεωμετρικά 

στοιχεία της. Τα υπόλοιπα κελιά του μενού παρέμεινα ως έχουν. Οι διατομές αυτές θα χρησιμοποιηθούν 

στη συνέχεια κατά τη δημιουργία των στοιχείων προσομοίωσης. Για τη δημιουργία της διατομής των 

καλωδίων του επίτονου ιστού δεν έγινε κάποια περαιτέρω διαδικασία από αυτήν που περιγράφεται και 

στο κεφάλαιο 4.1.4. 

7.1.3. Δημιουργία στοιχείων προσομοίωσης και διακριτοποίηση 

Όσον αφορά τα καλώδια, η δημιουργία των στοιχείων και η διακριτοποίησή έγινε με τον τρόπο που 

παρουσιάζεται στο κεφάλαιο 4.1.5. Τα πάνω καλώδια διαιρέθηκαν σε 40 ίσα τμήματα το κάθε ένα, ενώ 

τα κάτω καλώδια σε 20 ίσα τμήματα. Στο κορμό του ιστού, χωρίς να γίνει κάποια διακριτοποίηση, 

δημιουργήθηκαν απλά τα στοιχεία με τη βοήθεια των παρακάτω μενού. 

 Meshing > Element Groups: Τόσο τα κατακόρυφα στοιχεία όσο και τα οριζόντια και διαγώνια 

στοιχεία είναι τύπου Beam. Επιλέγουμε στη συνέχεια για κάθε ομάδα το υλικό και τη διατομή που 

έχουμε δημιουργήσει αρχικά. 

 Meshing > Create Mesh > Line: Επιλέγουμε τον τύπο και την ομάδα που θέλουμε να ανήκει το 

στοιχείο που θα αποδοθεί στην εκάστοτε γραμμή. Ο τύπος και στις δύο περιπτώσεις στοιχείων είναι 

Beam. Έπειτα εισάγουμε στον πίνακα του μενού τις γραμμές στις οποίες θέλουμε να εφαρμόσουμε 

αυτή την ομάδα στοιχείων. Εδώ χρειάζεται ιδιαίτερη προσοχή στην εισαγωγή του σημείου σύμφωνα 

με το οποίο ορίζεται ο προσανατολισμός της διατομής. Ουσιαστικά ορίζουμε ένα σημείο στα θετικά 

του τοπικού άξονα Υ του στοιχείου. Περισσότερες λεπτομέρειες ως προς τους τοπικούς άξονες και 

τον προσανατολισμό λαμβάνουμε πατώντας το κουμπί Help από το μενού Model > Cross Section. 

Προς το παρόν λοιπόν στο περιβάλλον του ADINA υπάρχουν οι γραμμές μόνο μέχρι το υψόμετρο 

των 5 μέτρων, οπότε σε αυτές εφαρμόζουμε τις ομάδες στοιχείων που θέλουμε και έχουμε 

δημιουργήσει ήδη. 

 Geometry > Lines > Define: Αφού έχει γίνει η διαδικασία για την κατάλληλη γεωμετρία και τη 

δημιουργία των στοιχείων προσομοίωσης μέχρι το υψόμετρο των 5 μέτρων, μένει ακόμα να 

δημιουργηθεί και το υπόλοιπο μέρος του ιστού. Επιλέγουμε αρχικά Add και ορίζουμε ως τύπο 

γραμμής Transformed. Με αυτή τη διαδικασία δηλώνουμε ότι θέλουμε να αντιγράψουμε μία ή 

περισσότερες γραμμές με ένα συγκεκριμένο τρόπο. Στο μενού που μεταφερόμαστε επιλέγουμε τον 

αριθμό των αντιγράφων και τη γραμμή που θέλουμε να αντιγράψουμε καθώς και περισσότερες στη 

λίστα Additional Parent Entities. Πρέπει να επιλέξουμε επίσης στο κελί Transformation Label τον 

τρόπο, που έχουμε ορίσει ήδη, σύμφωνα με τον οποίο θα γίνει η αντιγραφή. Ο ορισμός του 

περιγράφεται στο παρακάτω μενού. Ενεργοποιούμε τέλος και την επιλογή Copy Mesh into Element 

Group, επιλέγοντας μαζί και την ομάδα των εκάστοτε στοιχείων έτσι, ώστε με την αντιγραφή των 

γραμμών να μετατεθούν σε αυτές και οι ιδιότητες των αντίστοιχων στοιχείων προσομοίωσης. 

 Geometry > Transformations: Προσθέτουμε ένα καινούριο τύπο αντιγραφής. Στο μοντέλο μας οι 

τύποι που χρειαστήκαμε ήταν Translation και Rotation. Ο πρώτος για την μετάθεση των στοιχείων 

του κορμού προς τα πάνω και ο δεύτερος για την περιστροφική αντιγραφή των καλωδίων από μία 

θέση τοποθέτησης στις άλλες δύο. Η μετάθεση έγινε σύμφωνα με την επιλογή Coordinate Axes και 

τοποθετώντας στο κελί του άξονα Z τον αριθμό 5 καθώς έχουμε επανάληψη των στοιχείων ανά 5 

μέτρα στα θετικά του άξονα Z. Η περιστροφή έγινε σύμφωνα με την επιλογή Axis και Angle of 

Rotation να ισούται με 120ο γύρω από τον άξονα Z. 

7.1.4. Εισαγωγή φορτίων 

Το φορτίο του ανέμου ασκήθηκε, όπως αναφέρθηκε και προηγουμένως, σαν συγκεντρωμένα φορτία 

στον κορμό του ιστού. Οι τιμές των φορτίων αυτών πάρθηκαν ίδιες με αυτές που εισήχθησαν και στο 

πρόγραμμα SAP2000 έτσι, ώστε η σύγκριση που θα γίνει να προέρχεται από τα ίδια δεδομένα. 
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 Model > Constraints > Rigid Links: Δημιουργούμε διαφράγματα μεταξύ των δύο κόμβων του 

τριγώνου στα αρνητικά του άξονα Y, που υπάρχουν σε κάθε υψόμετρο. Αυτό απαιτεί την εισαγωγή 

σημείων στο μέσο της πλευράς των δύο αυτών σημείων, κοιτάζοντας σε κάτοψη τον ιστό μας. Στη 

συνέχεια από το μενού προσθέτουμε οκτώ διαφορετικά Rigid Links, ένα για κάθε υψόμετρο. Σε 

αυτά ορίζουμε ως Master το σημείο που δημιουργήσαμε στο μέσο της πλευράς και σαν Slave τα 

σημεία στα άκρα της πλευράς. Επιλέγουμε επίσης τους βαθμούς ελευθερίας στους οποίους θα 

συμφωνούν τα σημεία αυτά από το Slave Constrained DOF, εισάγοντας τους αντίστοιχους αριθμούς 

για κάθε βαθμό ελευθερίας όπως υποδηλώνει ο Πίνακας 7-1. Αυτό γίνεται για να μπορέσουμε να 

ασκήσουμε το φορτίο του ανέμου σαν ισοδύναμο στατικό φορτίο με ανάλογο προφίλ, όπως 

φαίνεται στην Εικόνα 7-4 του κεφαλαίου 7.2.4, με την τοποθέτησή του σε μορφή συγκεντρωμένων 

φορτίων σε κάθε Master κόμβο των Rigid Links. Στην Εικόνα 7-2 φαίνεται καθαρά ο ορισμός των 

Rigid Links και η επιβολή του φορτίου. 

Πίνακας 7-1: Αντιστοιχία βαθμών ελευθερίας με αριθμούς στο περιβάλλον του ADINA [7] 

X-Translation 1 

Y-Translation 2 

Z-Translation 3 

X-Rotation 4 

Y-Rotation 5 

Z-Rotation 6 

 

Εικόνα 7-2: Ορισμός Rigid Link και επιβολή φορτίου στο περιβάλλον του ADINA [7] 

 Control > Time Function: Τα Time Functions που εισήχθησαν εδώ φαίνονται στον Πίνακας 7-2.  

Ακολουθούν τη λογική των φορτίων των προηγούμενων μοντέλων. 

Πίνακας 7-2:Time Functions  

ΙΔΙΟ ΒΑΡΟΣ  ΦΟΡΤΙΟ ΑΝΕΜΟΥ 

Time Value  Time Value 

0.00 0.00  0.00 0.00 

0.01 1.00  0.01 0.00 

1.01 1.00  1.01 1.00 
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7.2. ΠΡΟΣΟΜΟΙΩΣΗ ΜΕ ΤΟ SAP2000 

7.2.1. Γεωμετρία φορέα 

 File > New Model: Από το μενού επιλέγουμε 3D Trusses και έπειτα ως πιο συγκεκριμένο τύπο το 

Guyed Tower. Χωρίς να κάνουμε κάποια άλλη αλλαγή μας εισάγει έναν ιστό με κορμό από δικτύωμα 

τριγωνικής κάτοψης όπως φαίνεται στην Εικόνα 7-3, που όμως χρήζει αλλαγές και από άποψη 

υλικών και από άποψη διατομών. 

  

(α) (β) 

Εικόνα 7-3: (α) Τρισδιάστατο μοντέλο και (β) κάτοψη μοντέλου στο περιβάλλον του SAP2000 [4] 

7.2.2. Δημιουργία διατομής 

Για τη δημιουργία των καλωδίων ακολουθήθηκε η διαδικασία που περιγράφεται στο κεφάλαιο 4.2.3, ενώ 

για τα στοιχεία του δικτυώματος ακολουθούμε την παρακάτω πορεία. 

 Define > Section Properties > Frame Sections: Για τα κατακόρυφα στοιχεία δημιουργούμε κοίλη 

κυκλική διατομή πατώντας Add New Property και στη συνέχεια Pipe. Έπειτα ορίζουμε τα γεωμετρικά 

της χαρακτηριστικά και το υλικό της και την αποθηκεύουμε με το επιθυμητό όνομα. Ίδια διαδικασία 

ακολουθούμε και για τις τριγωνικές διατομές των οριζόντιων και διαγώνιων στοιχείων, μόνο που 

εδώ επιλέγουμε διατομή τύπου Angle. 

7.2.3. Δημιουργία στοιχείων προσομοίωσης και διακριτοποίηση 

Πριν προχωρήσουμε σε οτιδήποτε αφαιρούμε τα στοιχεία που είναι στη θέση των καλωδίων καθώς δε 

μπορούμε να τα μεταβάλλουμε αυτόματα και τοποθετούμε στη θέση τους τη διατομή καλωδίου που 

δημιουργήσαμε. Από τη φόρμα που ανοίγει για την γεωμετρική επεξεργασία του καλωδίου επιλέγουμε, 

όσον αφορά την απόδοση της αρχικής γεωμετρίας, τον τύπο καλωδίου Cable – Relative Undeformed 

Length και ορίζουμε σαν Relative Undeformed Length το συντελεστή 1. 

 Assign > Assign to Group: Βάζουμε σε ομάδες τα τρία διαφορετικά είδη στοιχείων που έχουμε στο 

μοντέλο μας για διευκόλυνση στην επιλογή τους καθ’ όλη τη διάρκεια της επεξεργασίας. 

 Select > Select > Groups: Επιλέγουμε διαδοχικά την ομάδα στοιχείων που θέλουμε να 

μεταβάλλουμε. 

 Assign > Frame > Frame Sections: Έχοντας επιλέξει τα στοιχεία μιας ομάδας μέσω του 

προηγούμενου μενού, τα μεταβάλλουμε σε στοιχεία που έχουμε δημιουργήσει. 

 Edit > Replicate: Σε περίπτωση που φτιάξουμε το δικτύωμα του ιστού από την αρχή μπορούμε, 

αφού έχουμε εισάγει τα στοιχεία του μέχρι το υψόμετρο των 5 μέτρων, να τα αντιγράψουμε μέσω 
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αυτής της εντολής καθ’ ύψος. Το ίδιο μπορούμε να κάνουμε και με την τοποθέτηση των καλωδίων. 

Εισάγουμε ένα εσωτερικό και ένα εξωτερικό καλώδιο και στη συνέχεια τα αντιγράφουμε 

περιστροφικά. 

7.2.4. Εισαγωγή φορτίων 

 Assign > Joint > Constraints: Για την προσθήκη ισοδύναμου στατικού φορτίου ανέμου πρέπει να 

δημιουργηθούν ανάλογα constraints σε κάθε υψόμετρο του ιστού έτσι, ώστε να μπορεί να 

υπολογιστεί από το λογισμικό. Επιλέγουμε λοιπόν σε κάθε υψόμετρο τους δύο κόμβους της πλευράς 

του τριγώνου στα αρνητικά του άξονα Y. Στη συνέχεια στο μενού πατάμε Define Joint Constraints. 

Έχοντας επιλέξει ως τύπο Diaphragm προχωράμε σε προσθήκη νέου Constraint κατά τον άξονα Z 

και ενεργοποιούμε την επιλογή Assign a different diaphragm constraint to each different selected 

Z level για τη δημιουργία διαφορετικού constraint σε κάθε υψόμετρο. 

 Define > Load Patterns: Εισάγουμε καινούριο τύπο φορτίου πέρα από το ίδιο βάρος που 

πραγματοποιείται όπως και σε προηγούμενα μοντέλα. Αυτό ορίζεται με τύπο Wind και επιλογή για 

Auto Lateral Load Pattern αυτό του Eurocode1 2005. Έπειτα επεξεργαζόμαστε το φορτίο από την 

επιλογή Modify Lateral Load Pattern. Αφήνουμε τις προεπιλεγμένες επιλογές για τη δημιουργία του 

προφίλ του ανέμου και επιλέγουμε για την άσκηση του, Exposure from Extends of Rigid Diaphragms 

έτσι, ώστε να ασκηθεί στα διαφράγματα που δημιουργήθηκαν πριν. Έτσι το προφίλ του ισοδύναμου 

στατικού φορτίου του ανέμου που προκύπτει φαίνεται στην Εικόνα 7-4. 
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Εικόνα 7-4: Προφίλ ισοδύναμου στατικού φορτίου ανέμου κατά τα θετικά του άξονα Y 

7.3. ΠΡΟΣΟΜΟΙΩΣΗ ΜΕ ΤΟ ROBOT 

7.3.1. Γεωμετρία φορέα 

 Geometry > Axis Definition: Για την εύκολη εισαγωγή των στοιχείων του μοντέλου εισήγαμε ένα 

κυλινδρικό σύστημα συντεταγμένων, όπως ήταν και στο SAP2000 έτοιμο με την εισαγωγή του 

μοντέλου του ιστού από τα προεπιλεγμένα που υπάρχουν. Έχοντας λοιπόν σαν κέντρο την αρχή 

των αξόνων σχηματίσαμε τρεις κύκλους με ακτίνες στα σημεία που βρίσκονται οι ακμές του ιστού, 

έπειτα οι αγκυρώσεις των κάτω καλωδίων και τέλος οι αγκυρώσεις των πάνω καλωδίων. Αυτές οι 

αποστάσεις τοποθετούνται στην καρτέλα Radial του μενού. Έπειτα ορίζουμε να έχουμε ακτίνες ως 

οδηγούς στον κάναβο ανά 30ο στην καρτέλα Angle καθώς και σε κάθε υψόμετρο ανά 5m από την 

καρτέλα Z. 
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(α) (β) 

Εικόνα 7-5: (α) Τρισδιάστατο μοντέλο και (β) κάτοψη μοντέλου στο περιβάλλον του ROBOT [6] 

 Edit > Edit > Move/Copy: Αφού έχουμε δημιουργήσει το δικτύωμα μέχρι το ύψος των 5 μέτρων, 

στη συνέχεια το επιλέγουμε και το αντιγράφουμε καθ’ ύψος. 

 Edit > Edit > Rotate: Έχοντας τοποθετήσει ένα εσωτερικό και ένα εξωτερικό καλώδιο, μπορούμε 

να τα αντιγράψουμε περιστροφικά από το κέντρο των αξόνων για τη δημιουργία και των υπόλοιπων 

τεσσάρων καλωδίων. 

7.3.2. Εισαγωγή φορτίων 

Η εισαγωγή των φορτίων έγινε με τον ίδιο τρόπο όπως περιγράφηκε στο κεφάλαιο 4.3.6, καθώς 

πρόκειται για συγκεντρωμένα φορτία που επιβάλλαμε ανά υψόμετρο κατά τα θετικά του άξονα Y για 

την επιβολή ισοδύναμου στατικού φορτίου ανέμου, όπως ακριβώς έγινε και στο ADINA. Για το λόγο 

αυτό χρειάστηκε να δημιουργηθούν επίσης Rigid Links μεταξύ των κόμβων της πλευράς που ασκείται το 

φορτίο, πράγμα που εξηγείται στο παρακάτω μενού. 

 Geometry > Additional Attributes > Rigid Links: Αρχικά δημιουργούμε το Rigid Link που θέλουμε 

επιλέγοντας τους βαθμούς ελευθερίας που θα ενώνουν τα σημεία μας. Έπειτα εισάγουμε τον Master 

Node που είναι ο κόμβος που έχουμε δημιουργήσει στο μέσο της πλευράς και τους Slave Nodes 

που είναι οι δύο κόμβοι στα άκρα της πλευράς. Η διαδικασία που περιγράφηκε φαίνεται πιο 

ξεκάθαρα στην Εικόνα 7-6. 
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Εικόνα 7-6: Ορισμός Rigid Link και επιβολή φορτίου στο περιβάλλον του ROBOT [6] 

 Analysis > Analysis Types: Επιλέξαμε και εδώ το ίδιο βάρος να ασκείται σε ένα βήμα ενώ το φορ΄τιο 

του ανέμου σε 100 βήματα όπως και στα πρώτα μοντέλα. 

7.4. ΣΥΓΚΡΙΣΗ ΑΠΟΤΕΛΕΣΜΑΤΩΝ 

Παρακάτω θα παραθέσουμε τα αποτελέσματα από τα λογισμικά για τη μετακίνηση του κόμβου που 

φαίνεται στην Εικόνα 7-7 στα θετικά του άξονα Y. 

 

 

Εικόνα 7-7: Σημείο ελέγχου μετακίνησης επίτονου ιστού 
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Σχήμα 7-1: Σχέση μετακίνησης – φορτίου 

 

Σχήμα 7-2: Ομοιότητες μεταξύ αποτελεσμάτων στη μετακίνηση του σημείου ελέγχου κατά την άσκηση 
ισοδύναμου στατικού φορτίου ανέμου σε επίτονο ιστό 
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Σχήμα 7-3: Λεπτομέρεια από το Σχήμα 7-2 

7.4.1. Συμπέρασμα 

Στην περίπτωση του επίτονου ιστού παρατηρούμε επίσης μεγάλη σύγκλιση στα αποτελέσματα που μας 

δίνουν τα τρία λογισμικά. Παρατηρούμε όμως και το γεγονός ότι οι διαφορές είναι μεγαλύτερες σε ένα 

πιο σύνθετο μοντέλο όπως είναι ένας ιστός συγκριτικά με ένα πιο απλό μοντέλο όπως αυτό ενός 

μεμονωμένου καλωδίου.



 

 ΣΥΓΚΡΙΣΗ ΕΝΑΛΛΑΚΤΙΚΩΝ ΤΡΟΠΩΝ ΑΝΑΛΥΣΗΣ ΚΑΛΩΔΙΩΤΩΝ ΚΑΤΑΣΚΕΥΩΝ  

8. ΑΝΗΡΤΗΜΕΝΗ ΓΕΦΥΡΑ 

8.1. ΠΡΟΣΟΜΟΙΩΣΗ ΜΕ ΤΟ ADINA 

8.1.1. Γεωμετρία φορέα 

Η διαμόρφωση της γεωμετρίας του φορέα έγινε αρχικά με την τοποθέτηση σημείων στο χώρο που θα 

ενωθούν με ευθείες γραμμές για την τελικό σχηματισμό. Η διαδικασία για την τοποθέτηση σημείων και 

γραμμών έχει περιγραφεί στο κεφάλαιο 4.1.2. Ενδεικτικά τοποθετήθηκαν σημεία κατά μήκος του 

καταστρώματος ανά αποστάσεις των 10 μέτρων, στους πυλώνες, στις συνδέσεις των μελών τους, και 

τέλος στο ύψος του καταστρώματος κάτω από τα κεντρικά καλώδια για την τοποθέτηση στη συνέχεια 

των δευτερευόντων καλωδίων. Όσον αφορά τα κύρια καλώδια, επιθυμούμε να έχουν κρέμαση για την 

παραλαβή μεγαλύτερων φορτίων, οπότε θα μπορούσαμε να τα τοποθετήσουμε μέσω του μενού Arc 

όπως έγινε και στην περίπτωση του καλωδίου με κρέμαση. Αυτό όμως δε γίνεται καθώς κατά τη 

διακριτοποίηση σε ίσα τμήματα δεν θα προκύψουν σημεία με την ίδια τετμημένη με αυτά του 

καταστρώματος. Επιθυμούμε την ίδια τετμημένη για να είμαστε σίγουροι για την κατακορυφότητα των 

δευτερευόντων καλωδίων. Αυτό που κάνουμε λοιπόν είναι η δημιουργία τόσων σημείων κατά μήκος της 

καμπύλης του κύριου καλωδίου, όσων είναι τα δευτερεύοντα, δηλαδή πέντε στην περίπτωσή μας. Ο 

τελικός φορέας που προκύπτει φαίνεται στην Εικόνα 8-1. 

 

 

(α) (β) 

Εικόνα 8-1: (α) Τρισδιάστατο μοντέλο και (β) όψη μοντέλου ανηρτημένης γέφυρας στο περιβάλλον του ADINA 
[7] 
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8.1.2. Δημιουργία διατομής 

Model > Cross Sections: Δημιουργήσαμε τέσσερα διαφορετικά είδη διατομών, αυτά που αναφέρονται 

στο κεφάλαιο 3.5.2.3. Για τη δημιουργία του καταστρώματος χρησιμοποιήθηκε o τύπος Box για μία κοίλη 

διατομή. Για όλες τις υπόλοιπες διατομές, που είναι συμπαγείς, ο τύπος που επιλέχθηκε είναι Rectangular.  

8.1.3. Δημιουργία στοιχείων προσομοίωσης και διακριτοποίηση 

Όπως έχει αναφερθεί και στα προηγούμενα μοντέλα εφαρμόζουμε στις ήδη υπάρχουσες γραμμές τις 

ομάδες στοιχείων που έχουμε δημιουργήσει. Προσέχουμε επίσης τον προσανατολισμό των διατομών 

στα στοιχεία τύπου Beam. Στα κύρια καλώδια χρειάζεται να γίνει διακριτοποίηση καθώς αποτελούνται, 

με την ένωση των σημείων που αναφέρθηκαν, μόνο από έξι ευθεία τμήματα. Έτσι διαιρούμε το κάθε 

επιμέρους τμήμα σε πέντε μέρη. Επίσης ενώνουμε τα σημεία, που έχουμε δημιουργήσει στο ύψος του 

καταστρώματος για την ένωση του με τα δευτερεύοντα καλώδια, με τα σημεία των στοιχείων του 

καταστρώματος με Rigid Link έτσι, ώστε να μπορούν τα καλώδια να παραλάβουν τα φορτία από το 

κατάστρωμα. Τα Rigid Links φαίνονται στην Εικόνα 8-1 και είναι τα στοιχεία που είναι κάθετα στα 

στοιχεία του καταστρώματος. 

8.1.4. Εισαγωγή φορτίων 

Τα φορτία που ασκήθηκαν στο μοντέλο αυτό είναι το ίδιο βάρος της κατασκευής και ένα κατανεμημένο 

φορτίο των 100kN/m κατά μήκος του καταστρώματος. Η διαδικασία που ακολουθήθηκε είναι όμοια με 

αυτή του καλωδίου με κατανεμημένο φορτίο. Η επιβολή τέλος του φορτίου έγινε σε 100 βήματα. 

8.2. ΠΡΟΣΟΜΟΙΩΣΗ ΜΕ ΤΟ SAP2000 

8.2.1. Γεωμετρία φορέα 

 File > New Model: Φροντίζουμε να κάνουμε σωστές επιλογές κατά τον ορισμό του κανάβου έτσι, 

ώστε να είναι εύκολη η τοποθέτηση των στοιχείων της γέφυρας. Το τελικό αποτέλεσμα που 

προκύπτει λοιπόν είναι αυτό που φαίνεται στην Εικόνα 8-2. 

 

 

(α) (β) 

Εικόνα 8-2: (α) Τρισδιάστατο μοντέλο και (β) όψη ανηρτημένης γέφυρας στο περιβάλλον του SAP2000 [4] 

8.2.2. Δημιουργία διατομής 

 Define > Section Properties > Frame Sections: Πατώντας Add New Property εμφανίζονται οι 

επιλογές των διατομών που μπορούμε να δημιουργήσουμε από σκυρόδεμα αφού έχουμε αλλάξει 

την επιλογή Frame Section Property Type σε Concrete. Για τις διατομές λοιπόν των στοιχείων του 

πυλώνα επιλέγουμε τον τύπο Rectangular, ενώ για το κατάστρωμα κάνουμε την επιλογή τύπου 

Tube. 



ΑΝΗΡΤΗΜΕΝΗ ΓΕΦΥΡΑ  89 

 

8.2.3. Δημιουργία στοιχείων προσομοίωσης και διακριτοποίηση 

 Draw > Draw Special Joint: Τοποθετούμε στο ύψος των σημείων, που ενώνουν τα στοιχεία του 

καταστρώματος, σημεία που βρίσκονται κάτω από τα κύρια καλώδια για την ένωση των τελευταίων 

με το κατάστρωμα, μέσω δευτερευόντων καλωδίων. 

 Assign > Joint > Constraints: Πρέπει να ενώσουμε και τα μεμονωμένα σημεία που δημιουργήσαμε 

προηγουμένως με αυτά του καταστρώματος μέσω διαφράγματος. Αυτό έγινε με Constraint τύπου 

Body. Δημιουργήθηκε ξεχωριστό διάφραγμα για κάθε ομάδα σημείων με την ίδια τετμημένη. 

Επισημαίνονται γραφικά με πράσινο χρώμα οι κόμβοι ενός από τα διαφράγματα στην Εικόνα 8-3. 

Όμοια επαναλαμβάνεται και για τις υπόλοιπες ομάδες στοιχείων. 

 

Εικόνα 8-3: Χαρακτηριστικό διάφραγμα ανάμεσα σε σημεία του καταστρώματος 

 Draw > Draw Frame/Cable/Tendon: Δημιουργούμε όλα τα στοιχεία της γέφυρας μέσω του μενού 

αυτού. Όσον αφορά τα καλώδια εμφανίζεται και η αντίστοιχη φόρμα για την διαμόρφωση της 

αρχικής τους γεωμετρίας. Τόσο στα δευτερεύοντα καλώδια όσο και στα κύρια των ακραίων 

ανοιγμάτων επιλέγουμε να διαμορφώσουμε το Relative Undeformed Length το οποίο και ορίζουμε 

ως μονάδα. Για τα κύρια καλώδια όμως του μεσαίου ανοίγματος, για τα οποία επιθυμούμε να έχουν 

αρχική βύθιση, επιλέγουμε τη διαμόρφωση για Maximum Vertical Sag που το ορίζουμε ίσο με 10 

μέτρα στην περίπτωσή μας. 

8.3. ΠΡΟΣΟΜΟΙΩΣΗ ΜΕ ΤΟ ROBOT 

8.3.1. Γεωμετρία φορέα 

 Geometry > Axis Definition: Αφού ορίσουμε τον κάναβό μας προχωράμε στην τοποθέτηση των 

στοιχείων. Έτσι προκύπτει το τελικό αποτέλεσμα που εμφανίζεται στην Εικόνα 8-4. 

 Geometry > Nodes: Τοποθετούμε σημεία πάνω στην καμπύλη του κύριου καλωδίου για την ένωσή 

του, μέσω των δευτερευόντων με το κατάστρωμα. 

 Geometry > Additional Attributes > Rigid Links: Τοποθετούμε επίσης Rigid Links, όπως και στα 

άλλα λογισμικά ανάμεσα στους κόμβους του καταστρώματος και τους κάτω κόμβους των 

δευτερευόντων καλωδίων. Αυτά είναι εμφανή στην Εικόνα 8-4. 
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(α) (β) 

Εικόνα 8-4: (α) Τρισδιάστατο μοντέλο και (β) όψη ανηρτημένης γέφυρας στο περιβάλλον του ROBOT [6] 

8.3.2. Δημιουργία διατομής 

 Geometry > Properties > Cables: Φτιάχνουμε τρία είδη καλωδίων. Ένα για τα δευτερεύοντα 

καλώδια, ένα για τα κύρια των ακραίων ανοιγμάτων και ένα για τα κύρια του μεσαίου ανοίγματος. 

Για τα δύο πρώτα ορίζουμε Relative Elongation ίσο με 0, ενώ για το τρίτο ορίζουμε το μήκος του 

καλωδίου ίσο με 10.7m. Η τιμή αυτή προκύπτει καθώς έχουμε ορίσει τα καλώδια αυτά να 

αποτελούνται από 6 τμήματα, ενώ το συνολικό μήκος που θα έχει το καλώδιό με την κρέμαση είναι 

64.24m. 

 Geometry > Properties > Sections: Δημιουργούμε τις διατομές για τα υποστυλώματα και τις δοκούς 

των πυλώνων και για το κατάστρωμα. Αυτό γίνεται πατώντας το κουμπί New section definition και 

έπειτα στο Section Type επιλέξουμε RC Beam/RC Column. 

8.3.3. Δημιουργία στοιχείων προσομοίωσης και διακριτοποίηση 

 Geometry > Beams: Για την τοποθέτηση των δοκών και του καταστρώματος προχωράμε από το 

συγκεκριμένο μενού. 

 Geometry > Columns: Μέσω αυτού του μενού τοποθετούνται τα υποστυλώματα. 

8.4. ΣΥΓΚΡΙΣΗ ΑΠΟΤΕΛΕΣΜΑΤΩΝ 

Παρακάτω παρατίθενται τα διαγράμματα σύγκρισης των αποτελεσμάτων από τα τρία λογισμικά. Τα 

αποτελέσματα που παρουσιάζονται είναι για τον κόμβο ελέγχου στο μέσο του μεσαίου ανοίγματος της 

γέφυρας που εμφανίζεται και στην Εικόνα 8-5. 
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Εικόνα 8-5: Σημείο ελέγχου μετακίνησης στην ανηρτημένη γέφυρα 

 

Σχήμα 8-1: Σχέση μετακίνησης – φορτίου 
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Σχήμα 8-2: Ομοιότητες μεταξύ αποτελεσμάτων στη μετακίνηση του σημείου ελέγχου κατά την άσκηση 
κατανεμημένου φορτίου στο κατάστρωμα ανηρτημένης γέφυρας 

 

Σχήμα 8-3: Λεπτομέρεια από το Σχήμα 8-2 

8.4.1. Συμπέρασμα 

Όπως και στον επίτονο ιστό παρατηρούμε μικρές διαφορές ανάμεσα στα αποτελέσματα των τριών 

προγραμμάτων, οι οποίες όμως είναι μεγαλύτερης τάξεως από αυτές σε ένα μεμονωμένο καλώδιο. Με 

μια πιο περίπλοκη δηλαδή γεωμετρία φορέα έχουμε μία λίγο μεγαλύτερη απόκλιση μεταξύ των 

αποτελεσμάτων.



 

 ΣΥΓΚΡΙΣΗ ΕΝΑΛΛΑΚΤΙΚΩΝ ΤΡΟΠΩΝ ΑΝΑΛΥΣΗΣ ΚΑΛΩΔΙΩΤΩΝ ΚΑΤΑΣΚΕΥΩΝ  

9. ΚΑΛΩΔΙΩΤΗ ΓΕΦΥΡΑ ΑΚΤΙΝΙΚΟΥ ΤΥΠΟΥ 

9.1. ΠΡΟΣΟΜΟΙΩΣΗ ΜΕ ΤΟ ADINA 

9.1.1. Γεωμετρία φορέα 

Η διαδικασία που ακολουθείται για τη μόρφωση της καλωδιωτής γέφυρας είναι όμοια με αυτήν της 

ανηρτημένης. Τελικά προκύπτει το αποτέλεσμα που παρουσιάζεται στην Εικόνα 9-1. Πέρα από τη 

διαφορετική γεωμετρία τα επόμενα βήματα είναι ίδια με αυτά της ανηρτημένης γέφυρας. 

 

 

(α) (β) 

Εικόνα 9-1: (α) Τρισδιάστατο μοντέλο και (β) όψη καλωδιωτής γέφυρας ακτινικού τύπου στο περιβάλλον του 
ADINA [7] 

9.2. ΠΡΟΣΟΜΟΙΩΣΗ ΜΕ ΤΟ SAP2000 

9.2.1. Γεωμετρία φορέα 

Όμοια με την ανηρτημένη γέφυρα προχωρώντας εισάγουμε το φορέα μας. Αυτό που μπορεί να μας 

διευκολύνει είναι η εντολή Replicate με την οποία μπορούμε, όντας στο μοντέλο της ανηρτημένης 

γέφυρας, να μεταφέρουμε τους πυλώνες μας στη διαφορετική θέση που τους θέλουμε σε σχέση με το 

αρχικό μοντέλο. Εν τέλει σχηματίζεται ο φορέας που βλέπουμε στην  
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(α) (β) 

Εικόνα 9-2: (α) Τρισδιάστατο μοντέλο και (β) όψη καλωδιωτής γέφυρας ακτινικού τύπου στο περιβάλλον του 
SAP2000 [4] 

9.2.2. Δημιουργία στοιχείων προσομοίωσης και διακριτοποίηση 

 Draw > Draw Frame/Cable/Tendon: Όσον αφορά τα καλώδια στη φόρμα μορφοποίησής τους 

επιλέγουμε πάλι να μεταβάλλουμε το Relative Undeformed Length, το οποίο και ορίζουμε ίσο με τη 

μονάδα. 

9.3. ΠΡΟΣΟΜΟΙΩΣΗ ΜΕ ΤΟ ROBOT 

9.3.1. Γεωμετρία φορέα 

Τροποποιούμε το μοντέλο της ανηρτημένης γέφυρας μετακινώντας τους πυλώνες στη θέση που θέλουμε 

και τοποθετώντας τα καλώδια. Προκύπτει λοιπόν το μοντέλο της Εικόνα 9-3. 

 

 

(α) (β) 

Εικόνα 9-3: (α) Τρισδιάστατο μοντέλο και (β) όψη καλωδιωτής γέφυρας ακτινικού τύπου στο περιβάλλον του 
ROBOT [6] 

9.3.2. Δημιουργία διατομής 

 Geometry > Properties > Cables: Σε αυτό το μοντέλο δημιουργούμε ένα είδος καλωδίου για το 

οποίο ορίζουμε Relative Elongation ίσο με 0. 
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9.4. ΣΥΓΚΡΙΣΗ ΑΠΟΤΕΛΕΣΜΑΤΩΝ 

Παρουσιάζονται και για αυτό το μοντέλο τα αποτελέσματα συγκρινόμενα μεταξύ τους σε ένα διάγραμμα, 

καθώς και οι ποσοστιαίες ομοιότητες αυτών. Το σημείο ελέγχου και εδώ είναι το μέσο του 

καταστρώματος που φαίνεται στην Εικόνα 9-4. 

 

Εικόνα 9-4: Σημείο ελέγχου μετακίνησης στην καλωδιωτή γέφυρα ακτινικού τύπου 
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Σχήμα 9-1: Σχέση μετακίνησης – φορτίου 

 

Σχήμα 9-2: Ομοιότητες μεταξύ αποτελεσμάτων στη μετακίνηση του σημείου ελέγχου κατά την άσκηση 
κατανεμημένου φορτίου στο κατάστρωμα καλωδιωτής γέφυρας ακτινικού τύπου 
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Σχήμα 9-3: Λεπτομέρεια από το Σχήμα 9-2 

9.4.1. Συμπέρασμα 

Ίδιο συμπέρασμα και εδώ όπως και στην περίπτωση της ανηρτημένης γέφυρας. Δηλαδή όχι μεγάλες 

διαφορές ανάμεσα στα λογισμικά και λίγο μεγαλύτερες συγκριτικά με τα μοντέλα των μεμονωμένων 

καλωδίων.
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10. ΠΕΡΙΛΗΨΗ ΚΑΙ ΣΥΜΠΕΡΑΣΜΑΤΑ 

Μετά την αποτύπωση των αποτελεσμάτων σε διάφορους φορείς φορτισμένοι και με διαφορετικούς 

τρόπους, το κύριο συμπέρασμα που καταλήγουμε είναι ότι δεν υπάρχουν αισθητές διαφορές ανάμεσα 

στα τρία λογισμικά που εξετάστηκαν. Αυτό μας οδηγεί στην ελευθερία χρήσης και των τριών 

προγραμμάτων σε περίπτωση αντιμετώπισης ενός προβλήματος που απαιτεί την εκτέλεση μη γραμμικής 

ανάλυσης από άποψη γεωμετρικής μη γραμμικότητας. Και τα τρία λογισμικά έχουν τη δυνατότητα 

αντιμετώπισης φορέων με μη γραμμικά στοιχεία, στις περιπτώσεις των οποίων απαιτείται η χρήση της 

μεθόδου Full Newton-Raphson, που είναι μία από τις ενδεδειγμένες για τέτοιου είδους προβλήματα. 

Παρατηρούμε επίσης πως όσο πιο περίπλοκος γίνεται ένας φορέας, τόσο περισσότερο αποκλίνουν τα 

αποτελέσματα μεταξύ των τριών λογισμικών. Δηλαδή μεταβαίνοντας από ένα μεμονωμένο καλώδιο σε 

μεγαλύτερη κατασκευή όπως αυτή ενός επίτονου ιστού ή μίας γέφυρας, οι διαφορές αυξάνονται. Αυτό 

είναι πιο εμφανές και στο Σχήμα 10-1. 

 

Σχήμα 10-1: Διαφορές μεταξύ των αποτελεσμάτων στα τρία λογισμικά ανάλογα με την πολυπλοκότητα της 
γεωμετρίας του εκάστοτε φορέα 



100  ΚΕΦΑΛΑΙΟ 10 

ΜΕΤΑΠΤΥΧΙΑΚΗ ΕΡΓΑΣΙΑ ΤΟΥ ΔΗΜΗΤΡΙΟΥ ΠΑΠΑΔΟΓΙΑΝΝΑΚΗ Ε.Μ.Π. - 2020 

Τέλος, παρατηρούμε και αυτό που περιμέναμε από την αρχή για τους φορείς μεμονωμένων καλωδίων. 

Δηλαδή την αύξηση του φορτίου που μπορούν να παραλάβουν μέχρι την επίτευξη μίας συγκεκριμένης 

τιμής της αξονική τους έντασης και πιο συγκεκριμένα για τιμή T/(E×A)=0.01. Αυτό φαίνεται στον 

Πίνακας 10-1, στον Πίνακας 10-2 και στον Πίνακας 10-3. 

Πίνακας 10-1: Αύξηση παραλαβής φορτίου με την αύξηση της κρέμασης στην περίπτωση συγκεντρωμένου 
φορτίου 

Συγκεντρωμένο φορτίο 

Μήκος καλωδίου Φορτίο παραλαβής(kN) 

S0=1×L 25 

S0=1.05×L 90 

S0=1.10×L 100 

S0=1.15×L 140 

 

Πίνακας 10-2: Αύξηση παραλαβής φορτίου με την αύξηση της κρέμασης στην περίπτωση κατανεμημένου φορτίου 
κατά μήκος του τόξου 

Κατανεμημένο φορτίο κατά μήκος του τόξου 

Μήκος καλωδίου Φορτίο παραλαβής(kN/m) 

S0=1×L 9 

S0=1.05×L 20 

S0=1.10×L 25 

S0=1.15×L 30 

 

Πίνακας 10-3: Αύξηση παραλαβής φορτίου με την αύξηση της κρέμασης στην περίπτωση κατανεμημένου φορτίου 
κατά μήκος της οριζόντιας προβολής 

Κατανεμημένο φορτίο κατά μήκος της οριζόντιας προβολής 

Μήκος καλωδίου Φορτίο παραλαβής(kN/m) 

S0=1×L 9 

S0=1.05×L 20 

S0=1.10×L 25 

S0=1.15×L 30 
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